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This document is protected under copyright law.  An authorized licensee of Deko Select might reproduce this publication for 
the licensee’s own use in learning how to use the software. This document might not be reproduced or distributed, in whole or 
in part, for commercial purposes, such as selling copies of this document or providing support or educational services to 
others. This document is supplied as a guide for Deko Select. Reasonable care has been taken in preparing the information it 
contains. However, this document might contain omissions, technical inaccuracies, or typographical errors. Avid Technology, 
Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications 
are subject to change without notice.

Copyright © 2007 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
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GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — Broadcasters — Content 
creators of every genre — Just finished an incredible project and want to share it with the world?

Send us your reels and we might use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid Deko Select Installation and User’s Guide • 0130-07832-01 • March 2007 

http://www.avid.com/footage
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Using This Guide

The Avid® Deko Select Installation and User’s Guide is an instructional manual for 
installing and learning to use Avid Deko Select™ as well as a reference for day-to-day 
operation. This guide offers step-by-step instructions and general information. 

If you are responsible for installing Deko Select, carefully follow the instructions in the 
installation chapter. If you are responsible for installation or for creating Deko templates, see 
the chapter Preparing to Use Deko Select. If you are responsible for placing graphics in 
stories or for playout, you can find specific chapters for those tasks. However, you might 
want to read or skim all chapters to better understand how Deko Select works and what to do 
if you have difficulty.

References to the Newsroom Computer System, or NCS, apply to iNEWS® from Avid 
Technology and to ENPS® from Associated Press. Specific references to ENPS or iNEWS 
are made only where there is a difference. 

n The documentation describes the features and hardware of all models. Therefore, your 
system might not contain certain features and hardware that are covered in the 
documentation.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

If You Need Help

If you are having trouble using Deko Select:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after the 
documentation was published:

- If the latest information for your Avid product is provided as printed release notes, 
they ship with your application and are also available online.

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

t This symbol indicates a single-step procedure. Multiple arrows in a 
list indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you perform the mouse action. For 
example, Ctrl+drag.
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- If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation CD or DVD as a PDF document 
(README_DekoSelect.pdf) and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes 
available. To view these online versions, select ReadMe from the Help menu. or visit 
the Knowledge Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read or join online message-board discussions.

How to Order Documentation

To order additional copies of this documentation from within the United States, call Avid 
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the United 
States, contact your local Avid representative.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery 
methods that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator™ 
(ALEX), visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID 
(800-949-2843).

http://www.avid.com/onlinesupport
http://www.avid.com/readme 
http://learn.avid.com
http://www.avid.com/training
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Chapter 1

Welcome to Deko Select

Deko Select is a plug-in for a newsroom computer system’s interface that allows a user, such 
as a reporter, to drag and drop graphic templates directly into the story, as well as alter 
replaceable text or graphics in the selected template. Deko Select tightly integrates the Avid 
Deko line of character generators with your Newsroom Computer System (NCS). 

Any Deko graphic can be used as a template for Deko Select if the following conditions 
are met:

• Appropriate layers are designated as replaceable.

• Replaceable layers are properly identified, ordered, and named.

• Default playout channel is designated.

During script creation, you can preview and select graphics from the Deko Select Browser 
within the NCS. You can also add text, stills, or clips to a graphic template and preview 
exactly how each graphic will air.

In the control room, the iNews Command controls up to nine channels of Deko. Effects and 
clips are embedded in Deko templates so that the graphics air just as the art department 
intended. With Deko Select, you can easily manage multiple graphic looks to support 
different shows or channel branding.

The following topics describe Deko Select and the Newsroom:

• How Deko Select Enhances Newsroom Efficiency

• Understanding Deko Select

• Deko Select and the Newsroom Environment
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How Deko Select Enhances Newsroom Efficiency

The following topics contain information on how Deko Select enhances newsroom 
efficiency.

Traditional Methods for Supporting Stories with Graphics

The process of capturing a newsworthy event on camera, creating and editing a story about 
the event, and then presenting the story on-air involves several people and several media 
devices. After the initial shooting, the piece is edited and then stored either on a tape device 
or digitally on a video server. A reporter enters the story text into a NCS. The story is 
displayed on a teleprompter for the anchor to read and graphic elements are applied from 
other devices to identify and support the story. 

Depending on the size of the news department, there might be one or any number of 
reporters contributing to a single news program. Several media devices might be used in the 
process including, but not limited to:

• Video tape recorders, for playing a taped video recording of a story

• Video servers, for playing a digital video recording of a story

• Still stores, for accessing topical graphics, typically presented as over-the-shoulder 
graphics, to introduce a story   

• Character generators, for creating lower third, over-the-shoulder, full screen, or other 
graphics to identify and support story topics

• Teleprompters, to display the story script for the anchor to read   

The stories created by reporters are managed by the producer, who places them in an 
appropriate order for broadcast. This order is called a rundown. The rundown is entered as a 
list into the NCS, printed, and used as a guide for individuals operating the various media 
devices. The NCS can sort media, obtain newswire feeds and archive the stories of each 
reporter. 

The process of creating stories with graphics and placing them in a rundown must be 
repeated for each news program that airs. Each rundown is completely dynamic. During a 
news program, stories are added, dropped, and reordered, sometimes just before the story is 
intended to air. Traditionally, this forced individuals, sometimes in different locations, to 
scramble with their printed rundowns and reorder their tasks. If one person is not 
synchronized, there is a chance that the incorrect media will air.
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Using Deko Select to Support Stories with Graphics

Deko Select (formerly DekoMOS, where MOS stood for Media Object Server) is a 
communications protocol for management of media devices by newsroom computer 
systems. Deko Select facilitates and coordinates the use of various media devices in news 
presentation. Quick changes can be made more easily with less chance of error. Deko Select 
is used to control the Deko product line of character generators from Avid. Deko Select 
creates an active network link between each media device and the active rundown in the 
NCS. Through Deko Select, items for broadcast can be easily and quickly added, deleted, or 
reordered within a rundown.

Understanding Deko Select

Deko Select changes the workflow of newsroom operations by allowing the journalist, 
operator, or producer to:

• See all available graphic templates

• Access those templates

• Add text, stills, or clips to graphics with replaceable text boxes

• Preview the completed graphic

• Insert the completed graphic into a story

• Control playback of stories with a dynamic rundown 

Deko Select is currently available for the following newsroom computer systems:

• ENPS by Associated Press

• iNEWS by Avid Technology

Deko Select and the Newsroom Environment

Deko Select consists of several components working together, installed on different 
computers. Deko Select gathers information from other applications and distributes 
information to other applications. Understanding the relationship of Deko Select to other 
aspects of the newsroom environment is helpful. 

Your NCS, or server, organizes the newsroom. There is two-way communication between 
the server and other computers with the NCS client software. Each NCS client has the Deko 
Select Browser as a plug-in, functioning as part of the client software. The Deko Select 
Browser communicates with the DekoMOS Gateway. 
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The DekoMOS Gateway manages configuration information. It also is the communication 
link between the NCS and iNews Command to create and modify news rundowns. 

iNews Command controls playback of graphics on Deko systems, and can drive up to nine 
channels of Deko, across multiple systems, from a single user interface.

The DekoMOS Macro Server, installed on all Deko systems used for playout, allows iNews 
Command to communicate with the Dekos.

All Deko Select components should be installed and configured as specified in this guide; 
see “Installation and Setup” on page 25 and relevant NCS documentation.

n In this explanation, the term Deko refers to any one of these products: Deko 3000, Deko 
3000 Hybrid, Deko 3000 HD, FXDeko II, Deko 2200, Deko 1000, Deko 1000 Hybrid, Deko 
1000 HD, and Deko 550. Older versions of Deko Select (formerly known as DekoMOS) 
might not be compatible with all Deko models listed here. See the ReadMe for your 
application for minimum system requirements.

n NCS stands for Newsroom Computer System and might refer to iNEWS from Avid 
Technology or ENPS from Associated Press.

Architecture and Workflow

Avid iNEWS Command is scalable and can adapt to work in traditional newsroom-based 
playlist creation to production-centric workflows where running orders are created inside the 
iNEWS Command playback application. All of the components can run on a single 
computer, or they can be spread out across multiple computers with redundant services 
configured to take control if the primary services should become unavailable.
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An example of a basic Command system architecture is shown in the following illustration:

In the most common news workflow, playlists are created using the iNEWS newsroom 
computer system and the video and graphic assets are referenced in stories using their IDs or 
by dragging and dropping them from an Active-X plugin. 

Playlists can be saved to use later, stand-alone playlists can be created, and multiple playlists 
can be embedded in a single running order. You can set assets within a playlist to playback at 
a specified time, or you can set groups of assets to play in follow-on mode.
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A basic workflow is shown in the following illustration.

Deko Select Browser

Each client workstation displays an interface for creating stories. The Deko Select Browser 
is a plug-in for this interface that allows the reporter to drag and drop graphics templates into 
the story and alter replaceable text or graphics in the selected template. This interface is 
covered in detail in “Building Stories with Graphics” on page 87.
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Deko Select within the iNEWS client workstation interface 

Avid Graphics Select indicates that both Deko Select and Thunder 
Select are installed on this workstation. Notice the tabs for each plug-in.Deko Select tab
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Deko Select within the ENPS client workstation interface 

DekoMOS Gateway

The DekoMOS Gateway is the essential interface for communication between the NCS and 
all Deko Select components. Important configuration information allowing all Deko Select 
components to effectively communicate is stored here. The DekoMOS Gateway presents 
logs of DekoMOS activity and connections. For more information about installing and 
configuring the DekoMOS Gateway, see “Installing and Configuring the DekoMOS 
Gateway” on page 33.

Deko Select
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DekoMOS Gateway Interface

The following is an example of the DekoMOS Gateway interface.

DekoMOS Macro Server

The DekoMOS Macro Server is the communication link between the Playback Controller, 
the Gateway, and the Deko system. This component is installed on each Deko used for 
playout to air. For information about installing and configuring the DekoMOS Macro Server, 
see “Installing DekoMOS Macro Server on the Deko System” on page 56.
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DekoMOS Macro Server Interface

The following is an example of the DekoMOS Macro Server interface.



Chapter 2

Installation and Setup

Before you can use Deko Select effectively, you must properly install and configure the 
Deko Select components. 

This chapter includes the following:

• What information to gather before installing

• How and where to install Deko Select components

• How to configure Deko Select components

The following topics describe how to install and setup the components of your Deko Select 
system:

• Before You Install Deko Select

• Installing and Configuring the DekoMOS Gateway

• Viewing Options Enabled on the Net HASP

• Installing DekoMOS Macro Server on the Deko System

• Installing and Configuring Deko Select Software

• Locations of Installed Components
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Before You Install Deko Select

Before you install Deko Select, you must open the box and make sure you have the Deko 
Select Option contents, including the Net HASP enabling dongle (Application key), and 
software installation CD. Once you have verified that, there is additional information you 
must gather and preparations that you must make before installing and configuring 
Deko Select.

These functions are described in the following topics:

• Verifying Deko Select Option Contents

• Gathering Information

• Preparing Your System

• Configuring ENPS MOS Settings Before Installing on an ENPS NCS

• Connecting the Net HASP Dongle and Printer

• Confirming that the NetHASP License Manager is Running and Properly Configured

• Installing Software Components

Verifying Deko Select Option Contents

Verify that your Deko Select Option includes the following:

• A Net HASP enabling dongle

• An Installation CD with all Deko Select software components

• Deko Select Installation and User’s Guide (this guide) in .PDF format

n If you are configuring a system to integrate with iNEWS Command, see Chapter 6 of the 
Avid iNEWS Command Installation Guide.

Gathering Information

Before you begin the software installation, gather the following information regarding the 
systems on your site:

• The IP address of the NCS (the ENPS server or the iNEWS Command Gateway).

• The IP address of the fail-over NCS (needed for ENPS workstations only).

• The NCS ID (needed for iNEWS and ENPS workstations).

• The Gateway ID that you have decided upon and defined in the NCS. In iNEWS, this is 
defined in the system.mos-map.
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• The path name to the location where clients can access updates. This is optional is you 
enable Auto-updates on your system.

• The IP address of the computer with the Net HASP installed, typically the same 
computer as the DekoMOS Gateway. 

For the following, recommended defaults are displayed in the Configuration dialog box, but 
settings can be changed at your own risk:

• The default port number for the clients to communicate with the DekoMOS Gateway 
is 10542.

• The default port numbers for the DekoMOS Gateway to communicate with the ENPS 
server, if applicable, are 10540 for Media Objects and 10541 for Running Order.

• The port number for the Net HASP, default is 475.

Preparing Your System

The following topics contain information regarding preparing your system:

• File Storage Structure

• An Important Word about Fonts

• About Using Deko Select in a Non-Latin Language Environment

File Storage Structure

Deko Select components must be able to locate the Deko graphic template files and their 
components. Graphics for playout are stored on the Deko used for playout. Copies are stored 
on the DekoMOS Gateway for access by the Deko Select Browser from the NCS clients. 
Information about the file storage structure is entered and displayed in various configuration 
windows. For more about appropriate storage structure, see “Storage Structure for Graphic 
Components” on page 97.

An Important Word about Fonts

Any fonts used in templates intended for use with Deko Select must be installed on all 
computers, including Deko playout systems and NCS clients that access and display the 
templates. To install fonts, see the appropriate Windows documentation.

About Using Deko Select in a Non-Latin Language Environment

English and other Latin-based languages use a certain character set. Other languages use 
other characters. The language or languages that you can display depend upon system 
settings. For more information, see the appendix beginning on “Displaying Languages” on 
page 195, or the appropriate Windows documentation. 
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Deko Select currently uses single-byte characters to recall the appropriate glyph to display a 
character. When a byte is sent to Deko, Deko converts it to Unicode according to the current 
code page. The information is then maintained internally in Deko in Unicode. Most 
Truetype fonts have more than one lookup table. If they have more than 256 glyphs, then 
they must be able to find those glyphs, usually with a Unicode lookup table. Before Unicode, 
many non-English applications supplied their own fonts where all the glyphs are in the first 
256 positions. The applications had their own tables to know where the glyphs were stored. 
These fonts, possibly found in older graphics, do not work properly with more modern 
applications such as Deko Select.

iNEWS Command can be set to display fonts appropriate for languages other than English. 
See “Displaying Languages” on page 195.

Compatibility with Components in Previous Versions of Deko Select (DekoMOS)

Components of different versions of Deko Select (formerly DekoMOS) are compatible as 
indicated below. Many of the new features might not be available when connecting Deko 
Select to older components.

3.0 Gateway

• 2.1 Client, no 3.0 Client features

• 2.1 Macro Server

2.1 Gateway

• 3.0 Client, no global default graphic duration

• 3.0 Macro Server

Configuring ENPS MOS Settings Before Installing on an ENPS NCS

You need to configure the ENPS MOS settings before you install on an ENPS NCS.

You must be an ENPS Administrator to complete this process. 

To configure the ENPS MOS settings:

1. Open the ENPS client interface.

2. Click the green Rover button on the Corporate folder at the bottom of your screen, 
fourth from the left. This folder is typically labeled with your station call letters or 
corporate name. By default, it is labeled ENPS.
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Green Rover button
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3. Select System Maintenance > MOS Configuration.

A dialog box with a list of configured MOS plug-ins opens.

4. Click the New button.

The ENPS dialog box opens.

5. Type the same MOS ID that you will type in the DekoMOS Gateway configuration in 
the Gateway ID text box. 

6. Click OK.

A new row appears in the table. 

Click 
New 
button
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7. Double-click the row. 

The MOS Configuration dialog box opens.

8. Complete the text boxes as shown in the following table:

9. Select the Auto Create text box. 

10. Click OK.

11. Click Save.

MOS Configuration dialog box  

Text Box Name Type

Description The name that identifies this plug-in 
for users.

IP The IP address of the DekoMOS 
Gateway

ActiveX The ActiveX Application ID of the 
DekoMOS.Browser

Modal UI ActiveX The ActiveX Application ID of the 
DekoMOS.Browser
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Connecting the Net HASP Dongle and Printer

The Net HASP dongle included with your Deko Select system should be connected to the 
machine where you will install the DekoMOS Gateway. 

To connect the New HASP Dongle, do the following:

t Connect the dongle to either the parallel port or one of the USB ports on the back of 
the machine. 

To connect a printer to this computer, do the following:

t Connect the printer with a cable to the dongle just as you would directly to the port. The 
Net HASP dongle enables the Deko Select Option for the NCS clients. 

The Net HASP License Manager, the driver for the Net HASP, installs automatically with 
the DekoMOS Gateway. Avid recommends selecting Service as the installation option for 
the Net HASP License Manager. After installing, you should confirm that the Net HASP 
License Manager is running and that it is configured to use TCP/IP. 

Confirming that the NetHASP License Manager is Running and 
Properly Configured

To confirm that the NetHASP License Manager is running and properly configured:

1. Right-click the NetHASP License Manager Icon in the task tray at the bottom of your 
screen and select Show.

 The Net HASP License Manager window opens. You should see the words Server is 
listening to TCP/IP: Loaded and Net HASP License Manager is now - Active. 
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Installing Software Components

The Deko Select Option requires installation and configuration of four software 
components:

• Install the core components of the Avid Interplay Framework on the Deko. For more 
information, see Chapter 2 of the Avid iNEWS Command Installation Guide.

• Install DekoMOS Gateway on a PC with a network connection to the actual Deko 
device. The requires a USB dongle supplied by Avid. For more information, see 
“Installing and Configuring the DekoMOS Gateway” on page 33.

• Install DekoMOS Macro Server (on each playout Deko system). For more information, 
see “Installing DekoMOS Macro Server on the Deko System” on page 56.

• If your Deko is going to be integrated with Avid iNEWS Command, you must install the 
Avid iNEWS Command Server and Client software. For more information, see the 
iNEWS Command Installation Guide.

• Deko Select software (on all NCS client workstations). The Deko Select software 
includes the Browser and Editor. For more information, see “Installing and Configuring 
Deko Select Software” on page 61

Install each component as described on the following pages. The DekoMOS Gateway should 
be installed before the other components.

n Make sure Internet Explorer version 5.0 or higher is installed on all machines before 
installing Deko Select software components.

n When updating Deko Select from previous versions (formerly called DekoMOS), Avid 
recommends that you update all four components. Mixed versions might not be compatible 
or might have limited feature functionality. 

Installing and Configuring the DekoMOS Gateway 

This topic contains information on installing and configuring the DekoMOS Gateway.

The DekoMOS Gateway can not be installed on the iNEWS Gateway or ENPS Server. We 
recommend installing the DekoMOS Gateway on it’s own dedicated computer. 

The DekoMOS Gateway should be installed on a Windows® NT Server, a Windows 2000 
Server or a Windows 2003 Server Operating System. Otherwise, because of Windows 
limitations, the number of clients allowed to connect simultaneously is limited to ten. 
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These functions are described in the following topics:

• “Installing the DekoMOS Gateway” on page 34

• “Accessing the DekoMOS Gateway Configuration Window” on page 34

• “Configuring General Settings” on page 36

• “Configuring Connections” on page 39

• “Configuring Browser and Editor Settings” on page 42

• “Configuring Editor Macros” on page 43

• “Configuring Client Style Settings” on page 50

• “Adding Control Rooms” on page 54

Installing the DekoMOS Gateway

To install the DekoMOS Gateway:

1. Insert the Deko Select Installation CD into the CD drive of the DekoMOS Gateway 
machine. 

2. On the CD, navigate to DekoMOSGateway.exe. 

3. Click OK and follow the instructions on the screen to install the software.

Accessing the DekoMOS Gateway Configuration Window

To access the DekoMOS Gateway configuration window:

1. Determine if the DekoMOS Gateway is running. If the DekoMOS Gateway is 

- Not running, click Start > Programs > Avid Systems > DekoMOS > DekoMOS 
Gateway to run the DekoMOS Gateway application. 

- Running, right-click on the icon in the system tray on the taskbar to maximize 
the window.

If you have not previously configured the Gateway, or if it is missing any required 
information, the DekoMOS Gateway Configuration window will automatically open.

DekoMOS Gateway icon
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2. If it does not appear, do one of the following:

t Click the Configure button. 

t Press Alt+C. 

The DekoMOS Gateway Configuration window opens.

Once the DekoMOS Gateway is installed, you need to configure the following:

• General settings, including

- Enabling spell checking and spell check preferences

• Connection information, including:

- Confirming or adding enabled options and the number of enabled users 

• Browser and Editor settings, including:

- Configuring Editor macros

- Configuring third-party graphic or clip browsers

- Configuring a safe title area for graphics

• Client Styles settings

• Control Room settings

Configure 
button
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From the DekoMOS Gateway configuration window, you can also do the following:

• Configure General Settings. See “Configuring General Settings” on page 36

• Configure Connections. See “Configuring Connections” on page 39

• Configure Browser and Editor Settings. See “Configuring Browser and Editor Settings” 
on page 42

• Configure Editor Macros. See “Configuring Editor Macros” on page 43

• Configure Client Style Settings. See “Configuring Client Style Settings” on page 50

• Add Control Rooms. See “Adding Control Rooms” on page 54

Configuring General Settings

To configure general settings:

1. From the DekoMOS Gateway Configuration window, select the General tab. 

2. In the Paths area, type settings as follows:

t In the XML Storage Folder text box, type or browse to the pathname of the folder 
for storing active rundowns. If you type a folder name that does not exist, when you 
click OK you see a message asking if you would like the system to create this 
folder. This path is for the use of the Gateway and should therefore be local to this 
machine, beginning with a drive, C:, for example.

Paths 
area

Log Settings 
area
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t In the User Settings Storage Folder text box, type or browse to the pathname of the 
folder for storing individual user client settings. If you type a folder name that does 
not exist, when you click OK you see a message asking if you would like the system 
to create this folder. This path is for the use of the Gateway and should therefore be 
local to this machine, beginning with a drive, C:, for example.

t Select (recommended except when using languages without lexicons) or deselect 
Enable Spell Checking. In the Spell-Check Dictionary Folder text box, type the 
UNC name of the folder containing the lexicon files. It is important to use the full 
UNC name, beginning with \\, because this path is provided to the Deko Select 
browsers on the NCS client machines. By default, Deko Select installs the lexicon 
files to c:\program files\Avid\dekomos\lex. After installation, the administrator 
must share that folder so clients can read the lexicon files. The folder might be 
shared as Lex, so the pathname entered in the text box in the General tab would be 
\\Gateway\Lex, substituting the word Gateway with the name of the machine where 
the DekoMOS Gateway is installed. 

n For more information about file sharing, see your Windows documentation.

t Select Enable Auto-Updates. Once selected, Force Auto-Updates becomes enabled. 
The full UNC name, including file name, of the latest client installer should appear 
in the DekoMOS Client Installer text box. Using the full UNC name, beginning 
with \\ is important because this path is provided to the Deko Select browsers on the 
NCS client machines. Enabling auto-updates allows the system to automatically 
receive and install Deko Select software updates. Additionally, selecting Force 
Auto-Updates allows updates to install without offering you an option to decline 
updating. Updating requires restarting the NCS client machine. 

n You can create a folder in the Gateway machine for the DekoMOS Client Installer. To do 
this, name the folder C:\Updates. Copy the latest DekoMOSClient.exe installer into the 
folder and share the folder as Updates. The DekoMOS Client Installer text box in the 
General tab would then read \\(Gateway name)\Updates\DekoMOSClient.exe. 

t Click the Auto-Update Password button to display a prompt for entering the name, 
domain, and password of a local administrative account. Type the information. This 
information is encrypted in auto-update files, allowing individual clients without 
administrative privileges to install auto-updates. Click OK. 
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3. In the Log Settings area, select options as follows:

t For Log Detail Level, select High to show XML data in the Log of system activity. 
Select Medium for normal log activity. Select Low to show errors only. This setting 
is recommended unless you are troubleshooting. 

t Leave Max Lines at the default setting. 

t Select Display time in log lines (recommended) if you want the log to display the 
time, according to the system clock, when activity occurs.

t Select or deselect Hide Heartbeats. A heartbeat is a signal sent from one computer 
to another, requesting a return signal to confirm their connection. If selected, you 
see only the results of heartbeats you manually send, but not the ones the NCS 
initiates, or the ones the Gateway automatically sends. 

4. In the Startup Settings area, make the following selections 

t Select (recommended) or deselect Start Minimized according to your preference.

t Select Automatically Start on Boot-Up (recommended) to start the Gateway 
whenever you log on to this PC.

5. Click OK.
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Configuring Connections

To configure connections:

1. Access the DekoMOS Gateway Configuration window if it is not already open, and 
click the Connections tab.

2. In the Primary NCS area, type these settings:

t In the Address text box, type the IP address for the iNEWS Gateway or 
ENPS server 

t For the Lower Port, Avid recommends keeping the default setting of 10540 unless 
you receive an error message.

t For the Upper Port, Avid recommends keeping the default setting of 10541 unless 
you receive an error message.

3. Select or deselect Automatic Fail-over. If the Gateway loses connection to the NCS, the 
Gateway automatically tries to reconnect. If it cannot reconnect, and Automatic Fail-
over is enabled, the Gateway tries to connect to the fail-over NCS. If the Gateway 
cannot connect to the fail-over NCS, it continues to alternate connection attempts to the 
NCS and the fail-over NCS until it connects to one. If you enable Automatic Fail-over, 
type information in the Fail-over NCS area:

t In the Address text box, type the IP address for the fail-over iNEWS Gateway or 
ENPS server 

t For the Lower Port, type 10540.
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t For the Upper Port, type 10541

4. In the MOS IDs area, select one of the following buttons to configure your system for a 
single MOS ID or Multiple MOS IDs (Command systems only).

t If you select the Single MOS ID button, then, in the Gateway ID text box, type the 
MOS ID name that you have decided upon and defined in the NCS. 

n This unique MOS ID string enables every template that is dragged and dropped into a story 
to use the specified MOS ID.

t If you are using Command, you can select the MOS ID per Ch button (as shown in 
the following example) if you want the ability to drag and drop templates into 
specific channels. Once you select this button, the screen changes to reveal the 
Assign Channel IDs button. 

n With the MOS ID per Ch button selected, the MOS ID of the templates that are dragged and 
dropped into a story will vary depending on the channel the template was dropped with.

- If you select the MOS ID per Ch button, click the Assign Channel IDs button. The 
Configure Channel IDs dialog box opens.
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- For each Channel group listed in the Ch column (that is, 1, 2, 3, 4...), in the Gateway 
ID column, type in a corresponding MOS ID for the channels you want to use. Click 
OK to return to the DekoMOS Gateway Configuration dialog box.

5. In the NCS ID text box, type the NCS ID assigned by your System Administrator.

6. Select the “Reject items with incorrect Gateway ID” check box unless you are using 
Deko Select with an ENPS system and MOS Redirection. 

7. In the Listening Ports area:

t Client Port default setting is 10542. Avid recommends keeping this setting.

t PBC Port default setting is 10544. Avid recommends keeping this setting.

8. In the Net HASP Settings area:

t Type the IP address of the computer with the Net HASP installed if it is not already 
entered. The IP address text box automatically defaults to the address of the 
current machine.

t Keep the default setting of 475 in the Port field to indicate the Port number where 
the Net HASP checks for connections. This can be changed if you receive an 
error message.

9. Click OK.

n Using the Enabled Options button is described in “Viewing Options Enabled on the Net 
HASP” on page 54.
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Configuring Browser and Editor Settings

To configure the browser and editor settings:

1. Access the DekoMOS Gateway Configuration window if it is not already open. Click 
the Browser/Editor tab. 

2. In the Time Code area, select Use Time Code to enable clients to enter a time code when 
a graphic is added to a story. Make a selection from the list to specify the format of the 
time code. 

Default Graphic Duration allows graphics to play for the specified number of seconds 
from a specified in time without entering a duration or an out time when you place 
graphics in a rundown. You can override this setting later.

3. Select the appropriate Frame Rate setting, NTSC or PAL for your facility. 
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4. Click the Configure Safe Title Area Button. 

The Safe Title Area dialog box opens.

5. Select “Show safe title area” to display a red dotted border around the area of a template 
that one could safely assume would appear onscreen. Because the edges of an image 
might be clipped by an overscanning monitor, text placed outside the safe title area 
could appear off screen. In a broadcast environment, you should probably keep the 
recommended default settings of ten percent from the Top, Left, Right, and Bottom 
edges. In a different environment, with monitors of varying dimensions, you might want 
to adjust percentages. When you are finished, click OK.

6. In the Graphic Browsers and Clip Browsers areas, add, delete, or edit graphic or clip 
browsers. For more information, see “Configuring Deko Select to Access Images and 
Clips from Other Browsers” on page 46.

7. To configure Editor Macros, see “Configuring Editor Macros” on page 43.

8. Click OK.

Configuring Editor Macros

If there is a text string or special character that you know you frequently use in replaceable 
text boxes of the Deko templates, you can create a macro to type the text or character and 
then assign the macro to a keyboard shortcut for quick access. 

Examples of text you might want to enter with an editor macro would be an often used 
anchor name or a name that is difficult to spell. Editor macros are also useful for entering 
frequently used symbols such as an Up or Down arrow indicating the price change of stocks. 
Editor macros are defined from the DekoMOS Gateway. 
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These functions are described in the following topics:

• “Assigning Macros to a Single Key for Quick Access” on page 44

• “Configuring Deko Select to Access Images and Clips from Other Browsers” on 
page 46

• “Editing Graphic or Clip Browsers” on page 47

• “Deleting Graphic or Clip Browsers” on page 48

• “Selecting a Graphic or Clip Browser as the Default Browser” on page 49

• “Enabling Deko Select to Use Manual Entry” on page 49

Assigning Macros to a Single Key for Quick Access

To assign a macro to a single key for quick access:

1. Access the DekoMOS Gateway window.

2. Click the Configure button. 

The DekoMOS Gateway Configuration window opens.

3. Click the Browser/Editor tab.
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4. Click the Configure Editor Macros button.

The Editor Macros dialog box opens.

5. Click a letter in the left column to select the Key to which you want to assign a macro. 
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6. Click the Add button. 

The Add Editor Macro dialog box opens.

7. To assign a macro to a letter key, type the name of the macro in the Description text box. 
Then do one of the following:

t To create a macro for entering text, simply type that text in the Macro text box and 
then select Show macro contents when inserted.

t To create a macro for entering a symbol, picture, or for assigning a Deko preset 
style, in the Macro text box, type a “\” as an escape character, then type in a macro 
using commands found in the Shortcuts and Commands section of the Avid Deko 
Help. Uncheck Show macro contents when inserted. 

8. Click OK and then click OK again.

Configuring Deko Select to Access Images and Clips from Other Browsers 

Deko Select has the ability to access stills and clips to place in the editable text boxes of your 
templates. Access to the Deko Select browser or a third-party storage system must be 
configured from the DekoMOS Gateway. At this time, Xenotrack and Artbox from 
Proximity® is compatible. For more information, see “Using Other Products” on page 99.

To configure Deko Select for access to graphic or clip browsers:

1. Click the DekoMOS Gateway icon on the task bar to see the DekoMOS 
Gateway window.

2. Click the Configure button. 

The DekoMOS Gateway Configuration window opens.
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3. Click the Browser/Editor tab.

4. To add a graphic browser or a clip browser, click Add in the appropriate area. 

The Add Graphic Browser dialog box opens.

5. See the manufacturer’s instructions for the software application ID of the plug-in and 
type it in the AppID text box. 

6. In the Alias text box, type the name you would like to appear in the Deko Select 
Browser interface.

n If you want the ability to manually type in replaceable graphic names or numbers, see 
“Enabling Deko Select to Use Manual Entry” on page 49.

7. Click OK.

n If you want to delete Graphic or Clip browsers, see “Deleting Graphic or Clip Browsers” on 
page 48.

Editing Graphic or Clip Browsers

To edit a graphic or clip browser:

1. Highlight the browser in the list.

2. Click Edit.

The Add Graphic Browser dialog box opens with the AppID and the Alias for the 
selected browser. 

3. Make changes as desired.

4. Click OK.
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Deleting Graphic or Clip Browsers

To delete a graphic or clip browser:

1. Select the browser in the list.

2. Click the Delete button.

Browser name selected in list
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Selecting a Graphic or Clip Browser as the Default Browser

To select a graphic or clip browser as the default browser:

1. From the DekoMOS Gateway, select Configure > Browser/Editor.

2. Select the graphic or clip browser in the list.

Enabling Deko Select to Use Manual Entry

If you want the ability to manually type in replaceable graphic names or numbers, you must 
enable Deko Select to use manual entry functionality.

To enable Deko Select to use Manual entry:

1. Click Add in the Graphic Browsers area.

2. Type <manual> in the Alias area.

3. Type <manual> in the AppID area.

Select from the list
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4. Click OK.

Configuring Client Style Settings

Deko Select can easily manage and organize graphic templates to ensure the correct look or 
style of your broadcasts. For each programming entity, such as a station or a single show, 
that uses a distinct style, you can create a style name. You then assign paths to that style for 
the templates, graphics, and custom typefaces utilized for that look. You can reference this 
style from the client interface for easy access to the graphics appropriate for the station 
or show.

n All graphics in a single rundown must be from the same style. Adding graphics to a story is 
described in “Building Stories with Graphics” on page 87.

In the examples that follow, each template has the same name and the same number and 
types of layers. The background, the Dow Jones Industrials banner, and the Change, Close, 
and Volume Headings are all fixed layers. The Up or Down change indicators and the 
numeric values are all in replaceable text boxes filled in by a reporter or via automation. The 
Current Style determines which look appears by defining the paths to templates, fixed 
graphics, and replaceable graphics. Once a template is selected and the replaceable text 
boxes are filled, changing the Current Style changes the appearance of the graphic, but the 
information or graphics in replaceable text boxes remains. 
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An example of how a graphic might look, rendered in a certain style.

The same graphic, rendered in a different style.
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To add a style and define paths:

1. Access the DekoMOS Gateway Configuration window if it is not already open. Click 
the Client Styles tab.

2. Click the Add button. The Add Style dialog box opens. 

3. Type a style name in the Style Name text box. Click OK to accept the name and return to 
the Configuration dialog box. This is the name that will appear in the Deko Select 
plug-in on the client computers and in the iNews Command Inventory. 

n The Deko style is also referenced in the iNEWS system.map story for each rundown using the 
Deko with iNEWS Command.

4. If the style name you just added is not displayed in the Style Name text box, click the 
Down arrow beside the text box to display a list of style names. Click the Style Name to 
select it. 
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5. In each of the four Folder text boxes, type the path that the style should reference or 
press the browse button to the right of the text box to navigate to the appropriate folder. 
All clients will locate the elements for display in these folders. Avid recommends that 
they reside on the system where the DekoMOS Gateway is installed. 

The path you type must be a UNC path and not a drive letter path. The format for a UNC 
path is \\server\volume\directory\file and is not case-sensitive. For example:

\\Shared1_svr\Shared1\WGroups\Network\Orders.xls

n All folders should be shared for Read Only access. This ensures that the graphics remain as 
they were created while allowing access to those graphics. For best performance, files for 
playout are stored on the Deko. Duplicate files stored on the Gateway are accessed by the 
Deko Select Browser. 

n See the recommended file structure for graphics described in “Storage Structure for Graphic 
Components” on page 83.

6. Click OK. 

To change a style name:

1. Click the DekoMOS Gateway icon on the taskbar to see the DekoMOS 
Gateway window.

2. Select Configure > Client Styles.

3. Select the style to modify from the Style Name list.

The path you type 
must be a UNC 
path, and not a 
drive letter path.
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4. Click the Modify button, then change the style name. 

5. Click OK.

To change the appearance of a style:

1. Click the DekoMOS Gateway icon on the taskbar to see the DekoMOS 
Gateway window.

2. Select Configure > Client Styles.

3. Select the style to modify from the Style Name list.

4. To change the style's reference locations for the clients, in each of the four Folder text 
boxes, type the path that the style should reference, or press the Browse button to the 
right of the text box to navigate to the appropriate folder.

To delete a style:

1. Click the DekoMOS Gateway icon on the taskbar to see the DekoMOS 
Gateway window.

2. Select Configure > Client Styles.

3. Select the style to delete from the Style Name list.

4. Click the Delete button.

5. Click OK. 

Adding Control Rooms

If you are using Command, you do not need to add or configure a Control Room.

Viewing Options Enabled on the Net HASP

From the machine with the DekoMOS Gateway software installed, you can see a list of 
options and users enabled for Deko Select. Additional options or user licenses can be 
purchased from Avid, and must be enabled from the DekoMOS Gateway interface.

To see options and number of users enabled for Deko Select:

1. Click the DekoMOS Gateway icon on the taskbar.

The DekoMOS Gateway window opens.

 DekoMOS Gateway icon
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2. Click the Configure button, then click the Connections tab. 

3. Click the Enabled Options button. 

The HASP Options dialog box opens. A check mark appears beside enabled options.

n If you purchase additional options from Avid, you receive a SetOpt.mcr file with the enabling 
code for those options. If you purchase additional user licenses, the enabling code is sent to 
you in a SetLimit.mcr file.

To enable additional options or more users:

1. Start the DekoMOS Gateway.

2. Click the DekoMOS Gateway icon on the taskbar to see the DekoMOS 
Gateway window.

The DekoMOS Gateway window opens.

3. Click the Configure button, then click the Connections tab. 

4. Click the Enabled Options button. 

The HASP Options dialog box opens. 

 DekoMOS Gateway icon
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5. Click the Enable Options button on the HASP Options dialog box. 

The Enable Options dialog box opens. 

6. Do one of the following:

t Select Use .mcr file. Then, type in the name of the SetOpt.mcr or SetLimit.mcr file 
or locate it with the browse button.

t Select Manually enter enabling codes. Then, type the four multi-digit numbers of 
your purchased code in the four Enabling Code text boxes. 

7. Click OK. 

Installing DekoMOS Macro Server on the Deko 
System

The DekoMOS Macro Server is the communication connection with the iNEWS Command 
Playback Controller. Once installed on the Deko system, the Macro Server receives and 
processes macro commands. The DekoMOS Macro Server also acts as a client to the 
DekoMOS Gateway to retrieve a list of defined Styles from the Gateway. Once a style is 
defined in the DekoMOS Gateway and selected from the iNEWS Command Playback 
Controller, the Deko paths will be set according to the values configured in the DekoMOS 
Macro Server.

To install the DekoMOS Macro Server on the Deko:

1. Insert the Deko Select Option Installation CD in the Deko machine’s CD-ROM drive. 

2. On the CD, navigate to the DekoMOSMacroServer.exe file, then click OK or 
press Enter.

3. Follow the on-screen prompts to complete the installation. 
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Once you have installed the Deko MOS Macro Server on the Deko, you can do the 
following:

• Create macros to automatically start the DekoMOS Macro Server when Deko Starts. 
See “Creating Macros to Automatically Start the DekoMOS Macro Server When Deko 
Starts” on page 57.

• Configure the DekoMOS Macro Server. See “Configuring the DekoMOS Macro 
Server” on page 57.

• Configure styles and local paths. See “Configuring Styles and Corresponding Local 
Paths” on page 59.

Creating Macros to Automatically Start the DekoMOS Macro Server 
When Deko Starts

To create a macro to automatically start the DekoMOS Macro Server when Deko starts:

1. Select Start > Programs > Accessories > Notepad. 

2. In the Notepad text window, type the following, with no line breaks: 

shell open name="c:\Program 
Files\Avid\DekoMOS\DekoMosMacroServer.exe" 

3. Select File > Save File As. 

The Save File As dialog box opens.

4. Type the name init.mcr and save the file in Deko’s bin folder that matches the Deko 
model you are using (for example, C:\Deko1000\bin).

Configuring the DekoMOS Macro Server

To configure the DekoMOS Macro Server:

1. Do one of the following:

t If the DekoMOS Macro Server is not running, access the configuration window by 
clicking Start > Programs > Avid > DekoMOS > DekoMOS Macro Server.

t Double-click the desktop icon.

t If the DekoMOS Macro Server is running and is visible in the system tray, click the 
DekoMOS symbol in the system tray to maximize the application. 

The DekoMOS Macro Server window appears. The top portion of the window displays 
a log of DekoMOS Macro Server activity. 
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2. To specify that this log shows data communication in full xml view, select Details, near 
the bottom right of the window. Or, deselect Details to show a simple one line view. To 
clear the information displayed here, click the Clear button. 

3. In the Gateway Address text box, type the IP address of the machine running the 
DekoMOS Gateway. The Playback Port text box and the Local IP Port text box are 
10544 and 10543, respectively, by default. 

n Do not change these port numbers unless you receive an error message. The Playback Port 
number must be the same number you typed during DekoMOS Gateway configuration as the 
Playback Port. 

4. Click the Apply button below the Gateway Address text box.

5. Click Enable Logging if you want all logged information about Macro Server activity to 
be automatically sent to the folder Avid\DekoMOS\Logs. 
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6. Click Start Minimized to specify that upon starting the DekoMOS Macro Server will not 
display this window, but will appear in the system tray.

You can verify that the Macro Server is communicating with the Gateway. When the Macro 
Server is first started and correctly communicating with the DekoMOS Gateway, the LED 
light next to Gateway/Styles status turns green for a few seconds, then appears grayed out. If 
there is no communication, the light turns red, indicating that there is a problem talking to 
the Gateway.

You can verify that the Macro Server can confirm the existence of scheduled graphics, 
graphic assets, and clips. The LED lights next Template Graphics File Monitoring, and 
Replacement Graphic File Monitoring should be green. The Macro server must be able to 
monitor these files to communicate information to the Playback Controller. 

Configuring Styles and Corresponding Local Paths

To configure styles and corresponding local paths:

n The same style names, but with local paths, must be typed in the configuration of the Macro 
Server as were typed during Gateway configuration. For best performance, files for playout 
are stored on the Deko. Duplicate files stored on the Gateway are accessed by the Deko 
Select Browser. 

1. Access the configuration window by selecting Start > Programs > Avid >  DekoMOS > 
DekoMOS Macro Server. If the Macro Server is already running, click the icon in the 
system tray. 
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2. Click the Styles button. 

The Deko Style Settings dialog box opens. 

3. To configure styles defined in the DekoMOS Gateway, select the Style Name from the 
list and then set the appropriate paths that this style will use. When the Playback 
Controller sets a style, Deko uses the paths defined by the style. 

Although you should use the same paths as set in the DekoMOS Gateway for that style, 
paths should be local to this machine for best performance. 

4. In the Additional Macro Commands text box, type additional commands to send to 
Deko when the style is selected. This is useful for opening any show-specific presets or 
other files.

5. Click Apply to apply settings for a style. 
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6. Click OK when you have finished configuring styles.

To retrieve styles recently configured in DekoMOS Gateway and add them to the list of 
styles in the Deko Style Settings window:

t Click the Refresh Styles List button in the Deko Style Settings window.

Installing and Configuring Deko Select Software

Deko Select software must be installed on each client computer. 

After installation, you must configure Deko Select to communicate with the DekoMOS 
Gateway. Once Deko Select is installed and configured on one computer, the configuration 
files it produces (DekoMos.ini and NetHASP.ini) can be copied to the System32 folder on 
that computer. Then, both of those files can be copied to additional Deko Select clients that 
need to be configured

You can also configure individual user settings. The browser displays its contents and 
executes spell checking according to the preferences of each individual user.

These functions are described in the following topics:

• “Installing Avid Deko Select” on page 61

• “Configuring Deko Select” on page 62

• “Configuring User Preferences on a Client Computer” on page 63

• “Configuring Gateway Settings on a Client Computer” on page 64

• “Creating Toolbar Buttons and Shortcuts to Access the Browser from iNEWS” on 
page 67

Installing Avid Deko Select

The Deko Select plug-in allows iNEWS users to create CG items directly at the iNEWS 
Workstation, including changing background graphics, editing replaceable text, and setting 
In and Out points.

To install Avid Deko Select:

1. Ensure that the iNEWS client software is not running.

2. At the iNEWS Workstation, run the Deko Select installation program called 
DekoSelectClient.exe.

3. Log in to iNEWS.

4. Select Tools > Plugins > Avid Deko Select
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n If Thunder Select is also installed on the same workstation, the menu option will be Tools > 
Plugins > Avid Graphics Select.

5. In the Configuration dialog box, on the Gateway Configuration tab, enter the host name 
or IP address for the computer that is running the DekoMOS Gateway software.

6. Click OK.

n Templates exist on both the Deko MOS Gateway and the Deko device. The Deko MOS 
Gateway is then used to supply thumbnail graphics and handle file requests from plug-ins at 
multiple workstations, thus relieving such burden from the actual device that might be busy 
during playout. Duplication of assets on the gateway and device is not automatic; therefore, 
it must be maintain manually.

n To allow all clients to automatically access updates on one client, see “Installing and 
Configuring the DekoMOS Gateway” on page 33.

Configuring Deko Select

To configure Deko Select:

1. Open Deko Select in either the iNEWS or ENPS Client interface. If Deko Select has not 
been configured on this system before, the Configuration dialog box opens. Go to 
Step 4.

2. Click the Configure button on the Deko Select toolbar. If this is the first time opening 
Deko Select after installation, an error message appears stating that Deko Select is not 
configured.

3. Click OK.

The Configuration dialog box opens.
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4. Type the DekoMOS Gateway machine name in the Gateway Address field, and 
click OK.

Configuring User Preferences on a Client Computer

To configure User Preferences on a client computer:

1. Click the Configure button on the toolbar of Deko Select. 

2. Click the User Preferences tab.

3. Select options to indicate what you want Deko Select to display. 

4. Click OK. 
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Configuring Gateway Settings on a Client Computer

To configure Gateway settings on a client computer:

1. Click the Configure button on the toolbar of the Deko Select Browser. 

2. Click the Gateway Configuration tab.

3. Type the IP address of the computer where the DekoMOS Gateway is installed in the 
text box or browse to it.

The Gateway Browser Port is set to 10542. Do not change this default setting unless you 
have changed it in the DekoMOS Gateway configuration. 

4. Click OK.

Once you have configured the Gateway Settings on the first client computer, you can install 
them on additional clients from an .ini file. For more information, see “Configuring Gateway 
Settings on Additional Clients from an .ini File” on page 64. 

In addition, you can also configure the spell checker. For more information, see 
“Configuring the Spell Checker” on page 65.

Configuring Gateway Settings on Additional Clients from an .ini File

Gateway Settings, as configured above, are stored in a file called DekoMOS.ini in 
C:\WinNT\System32 or C\WINDOWS\system32. After installing and configuring 
Gateway settings on one client computer, you can copy this DekoMos.ini file onto any 
other machines rather than actually repeating the configuration procedure. 



Installing and Configuring Deko Select Software

65

Configuring the Spell Checker

To configure the Spell Checker:

1. Click the Configure button on the toolbar, then click the Editor Options tab.

2. Click the Configure Spell Checker button. 

The Spelling Options dialog box opens.

3. Select options as desired. for more information, see “Options Dialog Box” on page 128.
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4. Select a Main Dictionary language.

5. In the Suggestions area, select the option indicating the desired degree of accuracy.

6. Click OK.

To edit your Personal Dictionary:

1. Click the Configure button on the toolbar, then click the Editor Options tab.

2. Click the Edit Personal Dictionary button. The Spelling Dictionaries dialog box opens. 

3. Use the controls to add a word to your personal dictionary and associate another word 
and an action with that word. You can also delete words or import all of the words in a 
text file. For a detailed description of the controls in this window, see “Check-Spelling 
Dialog Box” on page 123.

4. Click Close.

To have spelling errors underlined as you type text in the Editor:

1. Click the Configure button on the toolbar, then click the Editor Options tab.

2. Select Enable In-line Spell Checking. 

3. Click OK.

n The underline displays in the editor, not in the graphic output.

To edit the Default Graphic Duration, for automatically setting the Out Time of graphic 
playout when you assign a graphic to a story:

1. Click the Configure button on the toolbar, then click the Editor Options tab.

2. Type a duration, in seconds, in the Default Graphic Duration text box.

3. Click OK.
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Creating Toolbar Buttons and Shortcuts to Access the Browser from 
iNEWS

The iNEWS Newsroom Computer System allows you to create toolbar buttons to access the 
Deko Select client. The iNEWS System Administrator can also create keyboard shortcuts 
giving the user direct access to Deko Select directly from the keyboard.

For more information, see the following topics:

• Creating a Deko Select Toolbar Button in iNEWS

• Creating Shortcuts to the Deko Select Editor in iNEWS

Creating a Deko Select Toolbar Button in iNEWS

To create a Deko Select toolbar button in the iNEWS interface:

1. Right-click one of the existing iNEWS tool bars and select Customize.

The Toolbars dialog box opens.

2. Click the New button.

3. Type a name for the new toolbar and then click OK.
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4. Click Add to add a new button.

The Customize Toolbar button dialog box opens. 

5. Type a name for the new button in the Name text box.

6. If desired, type descriptive text in the Tooltip Text text box. 

7. Click the Macro radio button.

8. In the Macro window type {alt TU}a.

9. Click OK to close the Customize Toolbar Button window.

10. In the Customize Toolbar window, click Text labels to show the button name under the 
toolbar button.

11. Click OK to close the Customize Toolbar window.

12. Click Yes to show the newly created toolbar. The toolbar is now floating on top of the 
iNEWS user interface. 

13. Click and drag to position as desired.
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Creating Shortcuts to the Deko Select Editor in iNEWS

A keyboard shortcut can be set up by the System Administrator. The iNEWS keyboard 
shortcuts are configured in the folder System.Keyboard. The example below assigns Deko 
Select to the function key Alt+F12

; ALT/F12DekoMOS

@{alt{f12}}~{alt TU}a

After the System Administrator has set up the new keyboard shortcut, you must reload 
the keyboard. 

To reload the keyboard, do one of the following: 

t Log off iNEWS and log on again.

t In iNEWS, select Tools > Options > Preferences. In the Preferences window that opens, 
click the Session tab, click Reload, then click OK.

Locations of Installed Components

All components are installed into subfolders in 
C:\ProgramFiles\PinnacleSystems\DekoMOS.

All components store their settings in C:\windows\system32\DekoMOS.ini. 

Shortcuts are created in: Windows Start menu\Programs\Avid\DekoMOS.

The DekoMOS Gateway creates an additional configuration file in the System32 folder 
named DekoMOSConfig.xml.
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Chapter 3

Preparing to Use Deko Select

In this chapter you will learn:

• How to create Deko templates with replaceable text boxes for use with Deko Select 

• How to structure paths and folders for storing graphic components

• Important information about using third-party components with Deko Select

The following topics describe how to prepare and use Deko Select:

• Creating Templates

• Storage Structure for Graphic Components

• Using Other Products

Creating Templates

Deko Select users have the convenience of selecting a graphic template for a story and filling 
in replaceable layers of the template with appropriate text, stills, or clips. Templates are not 
created with the Deko Select option itself. Templates for Deko Select are created on Deko 
character generators, such as Deko3000 or FXDekoII, or with PostDeko, the software only, 
offline creation tool. Any Deko graphic can be used as a template if the appropriate layers 
are replaceable. 

These functions are described in the following topics:

• “Creating Replaceable Layers in a Deko Graphic” on page 72

• “Troubleshooting Graphics” on page 81

• “Creating Static Design Elements for your Templates” on page 82
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• “Preparing Clips to Use with Templates” on page 83

Creating Replaceable Layers in a Deko Graphic

When creating replaceable layers in a Deko graphic, the procedure varies slightly depending 
on the type of replaceable layer you want to create. 

n These instructions apply to the Deko interface, not the Deko Select interface. For more 
information, see the Avid Deko Products User’s Guide.

To create replaceable layers in a Deko graphic:

1. In Deko, select a graphic to use as a template. Any graphic can serve as a template if you 
select a layer, then specify Replace, ID, Name, and Channel. 

2. Select the layer for the graphic. Make sure you have selected the layer, not the text 
within the layer. A selected layer displays grey handles on each side and corner of 
the layer.

n If your cursor sits inside the layer on the first character typed, with the Move tool selected, 
press the Page Up key to select the layer. 

Wrong: Cursor is in the layer. The layer is not 
selected. 

Correct: The layer is selected, as indicated by 
the handles displayed on each side and corner, 
shown above and in the close-up below.
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3. Access the Style window Layer tab.

n The Style window sometimes appears as the Text or Rectangle window, depending upon your 
most recent task and the layer selected.

4. Use the controls in the Style window, Layer tab, to do the following:

- Select Replace. 

n Replace allows the currently selected layer to accept external data. 

- Specify a consecutive ID number. 

n The ID number indicates the order in which layers accept external data. Each layer with an 
assigned ID number must have its own unique consecutive ID. Set the ID numbers in the 
order you want them to appear in the Deko Select Editor that opens with the Deko Select 
Browser within the newsroom client interface. If you do not specify layer ID numbers, Deko 
uses the layer orders as IDs. It places layer 1 text in the first replaceable layer it finds, layer 
2 in the next, and so on.

- Type a name for the layer in the Name field. 

n The name you assign to the layer should identify the type of information or image required 
for the reporter or producer. This name appears in the Deko Select Browser in the newsroom 
client interface. 

Layer Name assigned in 
Deko template creation 
appears in Deko Select 
Editor. 
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5. Save the layer. Make sure you give the template a name identifiable by Deko Select 
users, for example lower3 or 1line. You might also want to use a naming protocol to 
indicate clips or effects embedded in graphics, such as 1line_x to indicate an effect or 1 
line_c to indicate a clip. 

• In the Save Graphic As dialog box, use the graphics comment text box to designate the 
channel to which the graphic should play. Only the first character in the text box 
specifies a channel, and other comments can follow, for example, 2-Simple Lower 
Third. It is possible to override this channel later. 

n For more information about creating graphics with Deko, see the Avid Deko Products 
User’s Guide.

These functions are described in the following topics:

• “Creating a Replaceable Text Layer” on page 75

• “Creating a Replaceable Still or Image Layer” on page 78

• “Creating a Replaceable Clip Layer” on page 80

Indicates that graphic will play to channel 2
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Creating a Replaceable Text Layer

To create a replaceable text layer:

1. Do one of the following:

t Select File > Open and navigate to the graphic file you want to use as a template. 
Open the file into the Program window. 

t Clear the Program window and create a new graphic with one or more text layers. 
For more information, see the Avid Deko Products User’s Guide.

2. Select a text layer that you want to be replaceable. Remember, a solid box with handles 
on each side and corner of the layer box indicates a selected layer.

3. In the Style window, currently labeled as the Text window, click the Layer tab.

4. In the Auto-Update area, click Replace to accept external data into the currently selected 
layer. If you do not see these controls, click More.

Layer tab

Replace 
button
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5. Continuing near the bottom of the same window, the ID, by default, is Off. Off means 
that the layer number will indicate the order in which external data will be entered into 
the layers. Click the Up arrow to specify an ID number. This number indicates the order 
in which the data, defined in the Deko Select client plug-in, will populate layers. Layer 
IDs should be unique and consecutive.

n Duplicate layer IDs cause undesirable results.

6. Click the More button on the Style window to reveal additional controls, including the 
Name text box. 

Layer ID
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7. Type a name in the Name text box to identify the type of text required for the 
Reporter/Producer. This name will appear in the Deko Select Newsroom 
Client interface.

8. Click in the Program window displaying the graphic to activate it. 

9. Do one of the following:

t Select File > Save Graphic As

t Press F12

t Press Save File (FAK).

The Save Graphic As dialog box opens. 

10. Give the template a name identifiable by Deko Select users, for example lower3 
or 1line. 

Name 
text box
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11. Use the graphics comment text box to designate the channel to which the graphic should 
play. Only the first character in the text box specifies a channel, and other comments can 
follow, for example, 2-Simple Lower Third. If no comment is added, the graphic 
defaults to Channel 1. 

n It is possible to override the channel later. 

12. Click OK to save your graphic.

Creating a Replaceable Still or Image Layer

To create a replaceable still or image layer:

1. Open a new or existing Deko graphic. Create a rectangle layer with a face as the only 
detail. Use a texture for the face shader. For further instructions, see the Avid Deko 
Products User’s Guide.

2. Make sure that the layer is selected. 

3. In the Face Shader window, Texture tab, choose a default texture and check the Auto 
Replace box. From the AutoScale list, choose Fit, Crop, or Preserve, depending upon 
the shape of the rectangle and the graphics that can be used for this layer.

Designate a 
playout 
channel 
before saving 
the template.
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4. In the Style window, currently titled Rectangle window, click the Layer tab. For Auto 
Update choose Replace. Designate a Layer ID. If you do not see these controls on the 
layer tab, click More.

5. Click More. Click to place cursor in the Name text box and type a name for the layer. 

6. Remember to designate a channel with the first character in the Comment text box when 
you save. 
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When using the template, reporters can designate a still to populate the layer.

Creating a Replaceable Clip Layer

To create a replaceable clip layer:

1. Open a new or existing Deko graphic. 

2. Create a rectangle layer with a single face. 

For further instructions, see the Avid Deko Products User’s Guide. 

Rectangle layer with 
single face.



Creating Templates

81

3. In the Style window, currently titled Rectangle, click the Layer tab, for Auto Update 
choose Replace. Designate a unique, consecutive layer ID. If you do not see these 
controls on the Layer tab, click More.

4. For Associated, choose a default clip name from the list of available clips.

5. Click More.

6. Type a name for the layer in the Name text box. 

7. Remember to designate a channel with the first character in the comment text box when 
you save. 

8. So that reporters can see a picon representation of the clip in the Deko Select Browser, 
create a bitmap from the embedded background of the clip. Save it to the 
Elements_fixed folder with the same name as the clip.

Troubleshooting Graphics 

Despite a well-conceived design effort, some templates might not appear as intended when 
text or graphics are placed in the replaceable text boxes. Following is a check list for 
troubleshooting graphics problems within the Deko interface.

• Follow the four standard rules of Deko Select template creation:

- Replace on

- ID on

- Layer Name, appropriate for the layer

- Channel designation

• Turn Word wrap on or off, as appropriate.

• Turn Shrink to fit on as appropriate.

• Make sure layers are properly justified. For example, center justify for lottery numbers.

• Use unique, consecutive layer replacement ID numbers. 

• Texture layers must be set to replace in both the layer properties and in the shader. 

• Use correct layer names.

• Use correct layer order.

• Layer font style properties should be the same as the text in them. Deko Select 
automation only sees those layer properties.

• Check for duplicate layers. For example, a duplicate bullet layer in a full screen 
template, one right on top of the other is only noticed when you scroll through 
the layers.
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• Verify the correct font style before finalizing template. Problems can occur due to 
misinterpretation of how to obtain the desired effect. For example, Swiss Bold is 
obtained by using SwissBT and the BOLD feature. 

• Use correct opacity settings for shaders.

• Turn on or off details, such as shadows, as appropriate.

• Check that embedded effects and embedded clips work for the graphic.

• Position layers carefully to match with background elements as appropriate.

• Stay within the safe title area. 

• Make sure all correct fonts are installed on client and playout systems. 

Creating Static Design Elements for your Templates

Following are recommended guidelines for creating design elements for your graphic 
templates and importing images into Deko. These elements are commonly created in a paint 
application, such as Adobe Photoshop®, and imported into Deko. These can include banners, 
frames, logos, headshots, full-frame backgrounds and other items used to convey a show's 
distinct look.

Aspect Ratio

To ensure appropriate aspect ratio while in other square pixel graphic applications, such as 
Microsoft Paint, always work in 720 X 540 for NTSC and 768 X 576 for PAL. 

n If texture images originate from AP Graphics Bank, they were probably downloaded as 768 
X 576. If they are for use in an NTSC environment, a conversion can be done in 
Adobe Photoshop.

Textures

To ensure Deko's best handling of an imported image as a texture, always position textures 
center screen. Save texture images as TARGA files (.tga). This stores an alpha channel for 
keyable elements.

Scaling

To ensure that sizing and scaling of images in the template are consistent, always save in full 
resolution with the same center line and eye line. 

Find scaling options in the File Open dialog box. See your Avid Deko Products User’s Guide 
for file import instructions appropriate for your Deko model and version.
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Preparing Clips to Use with Templates

Moving video, commonly called clips, can come from a variety of sources. For more 
information, see the Avid Deko Products User’s Guide. 

Because a Deko Select template preview within the client application is a static image, clips 
cannot be previewed. However, you can create a bitmap to represent a clip in a 
template preview.

To create a representation of a clip for template preview:

1. When you create the clips for your templates, create a bitmap of a single frame (one that 
you want to be the representative frame). 

2. Save this bitmap with the same name as the clip. For example, if the clip file is named 
background.dv, save its bitmap representation as background.bmp. Save the bitmap file 
in the “Elements_Fixed” folder (on the central graphics storage system, usually the 
DekoMOS Gateway system). 

The thumbnails in the Deko Select Browser do not show the clip, but the Preview 
displays the representative frame.

Storage Structure for Graphic Components

Because Deko Select uses several software components installed on several hardware 
components, a viable and consistent directory structure for graphics is very important. The 
following sections include information about setting up directories for Deko Select systems 
shared by reporters for browsing, editing, and preview of on-air templates. 

These functions are described in the following topics:

• “Storing Files” on page 83

• “Creating a Storage Structure” on page 84

Storing Files

Files that must be stored include the following:

• Templates

The template is an entire graphic used for on-air display. Save templates separately from 
design elements that are part of the graphic. A design element is one part of the graphic, 
and can be fixed or replaceable. Saving the templates separately allows the DekoMOS 
browser to access only the templates, rather than populating with templates and 
individual elements. Within the template folder, you can have subfolders for better 
organization.
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• Static Elements

These design elements are not meant to be modified or replaced by the DekoMOS user. 
An example of a fixed element might be the station logo, or a permanent banner design. 
This type of design element should be stored separately from the templates and from 
replaceable elements. This folder can not have subfolders.

• Replaceable Elements

These design elements exist as dynamic components of graphics, and are meant to be 
altered or replaced frequently. An example of a replaceable element might be the topical 
image for an over the shoulder template. This type of design element should be stored 
separately from the templates and from fixed or static elements. This folder can not have 
subfolders. 

Creating a Storage Structure

A storage structure is recommended for systems intended for template design, and for shared 
storage for NCS client access to graphics (usually stored on the DekoMOS 
Gateway system). 

To create a storage structure for DekoMOS graphic components: 

1. Create the following folders in the directory titled DekoMOS_COMPONENTS, in the 
root of your system drive:

n It is important to include the underscore (_) symbol in place of spaces in all folder names. 
This facilitates technical support assistance.

n Sometimes a single facility has several control rooms or broadcast stations and therefore 
broadcasts multiple styles. In this situation, name the parent folders 
DekoMOS_Components_name of station or DekoMOS_Components_name of style.

n The Templates directory can contain subfolders to better organize graphics for the 
DekoMOS user. Those subfolders appear in the DekoMOS Browser interface. Other folders 
can not have subfolders.
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2. On the DekoMOS Gateway, using Windows Explorer, assign permissions to the folders 
as follows:

t Elements_Static: Read Only for everyone; Read/Write for specific users who save 
or move graphics to this location.

t Templates: Read Only for everyone; Read/Write for specific users who save or 
move graphics to this location.

t Elements_Replace: Read Only; When using graphics from a third-party, images 
transfer via FTP.

To ensure that client computers can see new or modified templates:

t Copy any templates modified or created on Deko to the Gateway. 

Using Other Products

Deko Select templates can include replaceable text boxes for still images or clips.

Stills and clips can enhance a story in a variety of ways. One example is a topical image 
introducing a story segment called an over-the-shoulder, or OTS, because the image is 
positioned just above and to the right or left of the anchor. Traditionally, OTS images are 
applied from a still-store device that sorts and manages large volumes of images. 

Often, artists enhance these images to better relay the story. Rather than just show a picture 
of a fire (left), an artist might combine partial graphics into one (right), and store this in a 
still-store media device for use the next time a story calls for a similar graphic. 

To manage these topical images, you can use third-party software to create and use a central 
database allowing the reporter to quickly order and insert OTS elements in their written story 
even as the story develops. 
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Chapter 4

Building Stories with Graphics

This chapter describes information on:

• Opening the Deko Select interface from your client computer (iNEWS or ENPS)

• Using the Browser to access graphics templates and place them in a story

• How to replace text, stills, or clips in the templates

The following topics describe how to build stories with graphics:

• Opening Deko Select

• Understanding the Deko Select Browser and Editor

• Changing the Deko Select Display

• Adding Graphics to a Story

• Adding Breaks to a Rundown

Opening Deko Select

There are two ways to open Deko Select, based on your Newsroom Computer system. 

These functions are described in the following topics:

• “Opening Deko Select at an iNEWS Workstation” on page 88

• “Opening Deko Select at an ENPS Workstation” on page 89

• “Understanding the Deko Select Browser and Editor” on page 90
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Opening Deko Select at an iNEWS Workstation

To open Deko Select at an iNEWS Workstation:

1. Log in to iNEWS. 

2. Select Tools > Plugins > Avid Deko Select.

The plug-in will open in a new workspace within the iNEWS window. It might appear at 
the top (as shown) or bottom, depending on the user’s preferences.

n Another plug-in available from Avid is Thunder Select. If both the Deko Select and Thunder 
Select plug-ins are installed, the name that will appear in the Tools > Plugins menu will be 
Avid Graphics Select. When chosen, both plug-ins will open in the workspace, with each 
plug-in available via tabs (shown) in the upper left corner of the workspace.

Preview Graphic

Browser Area 
(showing thumbnails) Replaceable FieldsPlug-in Tabs 
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Opening Deko Select at an ENPS Workstation
t If you are using ENPS, click the rover (green dot) on the ENPS Media Control Icon 

and then select Deko Select, or the name entered during configuration. 

The browser appears within the ENPS client workstation interface.
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Understanding the Deko Select Browser and 
Editor

Initially, the Deko Select Browser displays a list of available graphic template files. 

After you double-click a file to select it, the Deko Select Browser also displays an Editor, 
including a thumbnail of that graphic and a form for filling in the graphic's replaceable 
text boxes. 

List of available templates         Mini-preview               Replaceable Fields Editor
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The areas and functions of the browser are described in the following table.

Areas and Functions of the Browser  

Area Description

Preview Style List The list includes the styles configured on the DekoMOS Gateway. They 
must also be configured in the DekoMOS Macro Server for correct 
playout. Your selection determines the paths the browser searches to 
find graphics and templates specified by the files in the browser, and 
therefore the template file names displayed in the browser.

n If there is only one configured Preview style, the Preview Style 
list does not appear.

Toolbar buttons For more information, see “Toolbar Buttons” on page 93.

User This is the name that you use to log onto the system. The browser uses 
your preferences, including Preview Style and browser display options.

Current Folder This displays the name of the main folder specified in the Gateway 
under Styles as the Templates path, or the currently selected subfolder 
of that main folder. Subfolders can be used to organize your graphic 
templates. Examples of subfolders you might want to use include 
Sports, Full Screens, and OTS.

List of Available 
Templates and Folder

This list displays all folders and template files in the current folder. This 
can either be in text view or picon view.

Mini-Preview When a template is selected, this displays the template's appearance as 
created and saved, if all path settings are correct. After specifying text, 
stills, or clips in the Replaceable Fields Editor, this display updates 
automatically.

Deko Select Editor This editor displays a cell for each replaceable text box in the selected 
template. To the left of the cells, icons indicate whether the text box is a 
text box, still graphic text box, or clip text box. 
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In Time, Out Time, 
Duration

In these text boxes, type specifications about when the graphic should 
appear relative to the start of the show. Whether the editor includes a 
text box for Out Time or for Duration is determined by Gateway 
Settings. The information entered in these text boxes does not cause an 
action, but is displayed in the Playback Controller. An entry in one text 
box causes the other text boxes to change as follows:

• If the In Time is changed, Out Time automatically adjusts per the 
Duration. If no duration is entered, Out Times and Duration are 
adjusted per the default duration.

• If the Out Time is changed, the Duration automatically adjusts per 
the In Time.

• If the Duration is changed, the Out Time automatically adjusts per 
the In time.

Channel Selection The selected template displays its default channel assignment. To assign 
it to a different channel, select it from the list.

Full Preview Button Use the Full Preview button, or double click on the Mini Preview, to 
open a larger preview of the currently selected template with the text 
and graphics specified in the Replaceable Fields Editor.

Spell Check Click the Spell Check button to check spelling of all text typed in the 
editor for insertion in the replaceable text boxes.

If In-line spell checking is enabled, you see spelling errors underlined 
as you type in the editor. The underline does not display in the graphic 
output. 

For more information about configuring the Spell Checker, see 
“Configuring the Spell Checker” on page 65.

Favorites List The Browser can display a special section at the bottom of the window 
listing those template files designated as favorites. The Favorites list, 
described in “Simplifying Access to Template Files” on page 100, 
allows you to easily look for commonly used graphics without scanning 
the entire list in the browser. The Favorites list is specific to the current 
user, not the physical system. 

Areas and Functions of the Browser (Continued)  

Area Description
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Toolbar Buttons

The toolbar buttons on Deko Select are shown in the following illustration:

Changing the Deko Select Display

This topic contains information on how to configure the Deko Select user preferences, 
change the Browser and Editor display for your environment or workflow. In addition, it 
describes how to create an easier way to locate template files.

These functions are described in the following topics:

• “Configuring User Preferences” on page 93.

• “Configuring Editor Options” on page 96

• “Changing the Display” on page 96

• “Simplifying Access to Template Files” on page 100

Configuring User Preferences

To configure user preferences on a client computer:

1. To access the Configuration dialog box, do one of the following:

t Click the Configure button on the Deko Select toolbar.

t Press Alt + C. 

The Configuration dialog box opens.

Close Folder

Toggle On/Off 
Favorites List

Configure 
Browser

Toggle On/Off Editor

View Template 
Filenames

View Template 
Picons

Access Deko Select Help

Information about this 
version of Deko Select
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2. Click the User Preferences tab to configure individual user preferences. Settings are 
applied to the name used to log on to the system and are specific to that user, not 
the workstation.

3. In the Startup Options area, you can define what is included in the browser window at 
startup. Select the startup display option you want to see upon starting the application. 

Showing 
Picons
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4. In the Startup Folder section, select a style from the Preview Style list. To set the style as 
the default, click the Set as Default button. The Style you use defines the paths the 
browser uses to find templates and graphics. 

n In the Deko Select toolbar, the Preview Style section appears only if there is more than one 
Preview style defined.

5. Select the folder initially displayed in the browser. User defined is the default setting.

6. Click OK.

Showing 
Editor with 
file names

Showing 
Favorites
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Configuring Editor Options

When configuring Editor options, you can configure spell checking preferences and default 
graphic duration. The following topics provide you with information on how to get started in 
configuring Editor options, and provide references for more information.

To configure Editor Options, including spell checking and Default Graphic Duration:

1. To access the Configuration dialog box, do one of the following:

t Click the Configure button on the Deko Select toolbar.

t Press Alt + C. 

2. Click the Editor Options tab. For details, see instructions beginning on “Configuring 
Editor Macros” on page 43.

To configure Gateway settings:

1. To access the Configuration dialog box, do one of the following:

t Click the Configure button on the Deko Select toolbar.

t Press Alt + C.

2. Click the Gateway Configuration tab. For details, see instructions beginning on 
“Installing and Configuring the DekoMOS Gateway” on page 33. 

Changing the Display

Once you have Deko Select up and running, you can change the display to match your 
preferences.

These functions are described in the following topics:

• “Switching Between Template File Names or Template Picons in the Browser” on 
page 97

• “Showing or Hiding the Editor” on page 97

• “Showing or Hiding the Favorite Templates List” on page 97

• “Viewing the Contents of a Folder in the Browser” on page 97

• “Closing a Folder and returning to the Previous Level in the Browser” on page 98

• “Enabling and Disabling In-Line Spell Checking in the Editor” on page 98
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Switching Between Template File Names or Template Picons in the Browser

To switch between template filenames or template picons in the Browser:

t Do one of the following:

- Press Alt+T.

- Click one of the toolbar buttons. 

Showing or Hiding the Editor

To show or hide the Editor:

t Do one of the following:

- Press Alt+E.

- Click the toolbar button. 

The Deko Select Editor opens automatically when you double-click a file in 
the Browser.

Showing or Hiding the Favorite Templates List

To show or hide the Favorite Templates list:

t Do one of the following:

- Press Alt+F.

- Click the toolbar button. 

Viewing the Contents of a Folder in the Browser

To view the contents of a folder in the Browser:

t Double-click on the folder to Select and Open it. 

The folder name appears in the Current Folder text box of the Browser. File names or 
picons of templates in that folder appear in the Browser.

Display template file names button

Display template picons button
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Closing a Folder and returning to the Previous Level in the Browser

To close a folder and return to the previous level in the Browser:

t Click the Folder icon at the left of the Toolbar.

Enabling and Disabling In-Line Spell Checking in the Editor

Deko Select provides you with the ability to turn on and off in-line spell checking. When 
turned on, in-line spell checking underlines possible spelling errors as you type in the Editor.

For more information, see the following topics:

• “Enabling In-Line Spell Checking” on page 98

• “Disabling In-Line Spell Checking” on page 99

Enabling In-Line Spell Checking

To enable in-line spell checking in the Editor: 

1. Do one of the following:

t Click the Configure button on the Deko Select toolbar.

t Press Alt + C.

The Configuration dialog box opens.

2. Click the Editor Options tab.
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3. Select Enable In-line Spell Checking.

With In-Line Spell Checking enabled, possible spelling errors appear underlined as you 
type in the editor to fill the text boxes of a graphic. Whether or not you choose to change 
the spelling of the word or words, the underline does not appear in the graphic itself 
during preview or playout.

4. Click OK.

Disabling In-Line Spell Checking

To disable in-line spell checking in the Editor: 

1. Do one of the following:

t Click the Configure button on the Deko Select toolbar.

t Press Alt + C.

The Configuration dialog box opens.

2. Click the Editor Options tab.

3. Deselect Enable In-line Spell Checking. 

4. Click OK.
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Simplifying Access to Template Files

This topic provides information on ways to get easier access to your template files.

For more information, see the following topics:

• “Placing a File in the Favorites List” on page 100

• “Removing a File from the Favorites List” on page 100

• “Assigning a File to a Hot Key for Easy Keyboard Access” on page 100

Placing a File in the Favorites List

To place a file in the Favorites list:

t Right-click on a template in the main browse and select Add to Favorites. 

n This procedure works whether or not the Favorites list is currently displayed. 

Removing a File from the Favorites List

To remove a file from the Favorites list:

1. Right-click the file in the Favorites list.

2. Select Remove From Favorites. 

Assigning a File to a Hot Key for Easy Keyboard Access

To assign a file to a hotkey for easy keyboard access:

1. Right-click a template in the main browser. 

2. Select Assign to Hotkey.

The Assign to Hotkey dialog box opens.

3. Assign the file to a hotkey with a modifier key. Note that some keys are already used by 
the NCS.
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Adding Graphics to a Story

Deko Select allows you to choose graphics with replaceable text boxes for your story in the 
Browser. Once a graphic is selected, the Editor displays, allowing you to type in text or 
browse to stills and clips to fill the replaceable text boxes.

Deko Select can be linked to an additional graphics management system such as Proximity's 
Xenotrack or Artbox. You can browse for graphics in this storage system and simply drag 
and drop from the Browser to the Preview Graphic area of the Editor to fill the replaceable 
image text boxes of your templates.

The procedures for inserting Deko Select Events into stories are different depending on 
whether you are using iNEWS or ENPS.

These functions are described in the following topics:

• “Inserting Deko Select Events into iNEWS Stories” on page 101

• “Inserting Deko Select Events into ENPS Stories” on page 104

Inserting Deko Select Events into iNEWS Stories

Deko Select events can be inserted directly into the body of a news story or inserted into the 
story form as a primary machine control event.

n Dropping events into the story form is available only if the Deko is the primary device, which 
is usually not the case when a video device is also used, such as an AirSpeed video server.

To insert a Deko event into the story form:

1. From an iNEWS Workstation, open the story in which you want to insert the Deko 
Select event.

2. With the Deko Select workspace open in the iNEWS window, select a Deko Select event 
and drag it to the Story Form panel in the iNEWS workspace. For more information on 
the Story Form panel, see the iNEWS Command User’s Guide.

n You do not have to drop the event onto a specific field in the form.

To insert a Deko event into an iNEWS story using Deko Select:

1. From an iNEWS Workstation, open the story in which you want to insert the Deko 
event.

2. (Optional) Position cursor in the story where you want the production cue marker to be, 
and insert it by typing Alt+Insert.
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3. With the Deko Select workspace open in the iNEWS window, double-click on a 
template’s file name or thumbnail. For more information on accessing the Deko Select 
plug-in, see “Opening Deko Select at an iNEWS Workstation” on page 88. A preview of 
the template will appear on the bottom right of the workspace.

n When multiple plug-ins are installed, such as Deko Select and Thunder Select, the 
workspace is known as the Avid Graphics Select workspace; the individual plug-ins are then 
accessible by clicking on tabs available in the upper left corner of the workspace.

4. Above the preview, type information into the replaceable fields as needed. If default text 
was included in the template, it will appear automatically, but can be replaced.

5. (Optional) The selected template displays its default channel assignment, but a different 
channel can be selected from the Channel list.

6. (Optional) To view a larger preview of the currently selected template with the edited 
fields, do one of the following:

t Double-click on the preview graphic.

t Click the Full Preview button.

7. (Optional) Use the Spell Check button to check spelling of text in the replaceable fields.

n If In-line spelling is enabled, Deko Select will underline spelling errors as the user types in 
the fields. The underline will not appear in the graphic output. For more information, see 
“Enabling and Disabling In-Line Spell Checking in the Editor” on page 98.

Browser Area
(showing file names)

Preview Graphic

Replaceable Fields

Channel List

Plug-in Tabs 
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8. (Optional) Enter In and Out or Duration settings for a “tagged” event.

An example of a tagged event is when a character generated graphic is set to 
automatically go on-air at a specific time and for a specific duration during a video 
event. Timecode information specified in the plug-in is forwarded to the Command 
Workstation and appears in the playlist so that the operator knows when this automatic 
event will occur. 

n Administrators at sites that want to take such events to air manually can turn off the 
automatic functionality by modifying a system setting in Avid iNEWS Command.

9. When finished editing, drag and drop the preview graphic into the story. A production 
cue marker is inserted in the story’s text and the Deko Select information will appear in 
the Instruction panel on the left side of the Story panel. The font will be blue to indicate 
a machine control event as opposed to a production cue.

When the story is completed and saved, any Deko Select events become part of the story. 
When a rundown’s monitor server is loaded, the playlist, including any Deko Select events 
will be published to iNEWS Command (and the Avid Playlist Controller). In iNEWS, when 
the monitor server is turned on and loaded, the iNEWS rundown’s playlist is sent to 
Command.
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Editing Replaceable Fields of a Deko Select Event in an iNEWS Story

To edit the replaceable fields of a Deko Select event in an iNEWS story:

1. Open the story and do one of the following:

t Double-click the Production Cue text box containing the machine control event, 
displayed in the Instruction panel.

t With the cursor in the Production Cue text box, press Enter.

When the Deko Select plug-in opens, an image of the template will appear as a preview 
graphic, above which the current contents of the replaceable fields will be displayed.

2. (Optional) Change the background by pressing Enter and selecting another one.

3. Edit the replaceable fields as needed.

4. (Optional) Edit the In, Out, and Duration time.

5. Set the channel, if needed.

6. Click OK to save and exit the plug-in. The edited graphic will replace its previous 
version in the story.

Inserting Deko Select Events into ENPS Stories

Deko Select events can be inserted into ENPS Stories. This process includes choosing a 
template, filling in the blanks, and placing it in a story.
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To insert Deko Select Events into ENPS Stories:

1. Type your script into the text window of the client interface.

Story in iNEWS interface
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2. At any time, to select a graphic template, double-click a file name or a thumbnail of a 
template in the Browser. 

The Editor opens with a preview of the template in the Mini-Preview section. The Editor 
displays a cell for each replaceable text box in the template. An icon in the left column 
of the table indicates the type of replaceable text box.

In the ENPS interface, you can also do the following:

- Press Shift + Tab to activate the Browser. 

- Press the Up or Down arrow keys to highlight a Deko graphic file. 

- Press Enter to select the file and display the Editor. 

The Editor displays a cell for each replaceable text box in the template. An icon in the 
left column of the table indicates the type of replaceable text box. 

Story in ENPS interface
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3. For each text box displayed in the Editor, type in the desired text. 

n If the graphic was created with default text in the layer, this text appears in the Editor, but 
you can select and change it.

4. For each still text box that you want to edit, double-click the layer name to open the 
DekoMOS Stills Browser.

5. Drag a file from the Deko Select Stills Browser and drop the file onto the appropriate 
line in the Editor. 

Double click file name, or picon, in 
browser 

Preview graphic of the template 
you selected appears here 

Type text or insert stills and 
clips into text boxes with this
editor

Double-click here
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6. Click anywhere outside this browser to close it. If more than one image browser is 
configured, as described in “Configuring Deko Select” on page 62, you can select the 
browser of your choice with the tab on the left side of this window.

n Appropriate storage structure is essential if you use this method of template fulfillment. Stills 
must be in the Replaceable Graphic directory. The representative bitmaps for the clips must 
be in either the Replaceable Graphic directory or the Static Graphic directory. The clips 
should be imported to the clip database of the playout Deko Machine.

7. For each clip text box that you want to edit, double-click the layer name to open the 
Insert Clip dialog box. In the Insert Clip dialog box, type the Clip Name and the Clip 
Alias, and then click OK.

The Mini-Preview automatically updates to show how your graphic will appear. 

Double click layer name in Editor

Type in the Clip file 
name and Alias, and 
then click OK
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8. Click the Full Preview button to see a larger view.

9. To add the item to the story, do one of the following:

t Drag and drop the Mini-Preview into the story.

t Press Ctrl + Enter. This shortcut works only with ENPS. This automatically saves 
the item, activates the story window, and returns the cursor to the story.

When the story is completed and saved, these Deko Select objects become part of the 
story. 

n All graphics in a single rundown must be from the same style. For more information about 
Deko Select styles, see information beginning on “Configuring Client Style Settings” on 
page 50.

These functions are described in the following topics:

• “Tabbing Through Text Boxes in the Editor” on page 109

• “Entering Often Used Text or Graphics into a Replaceable Text Box” on page 110

• “Editing Text Boxes in a Graphic in an ENPS Story” on page 110

• “Changing Deko Select Graphic Templates but Preserving the Contents of Replaceable 
Text Boxes” on page 111

Tabbing Through Text Boxes in the Editor

To tab through text boxes in the editor:

t Do one of the following:

- Press Tab.

- Press Enter.

You can preconfigure keystroke shortcuts for entering text or graphics into a replaceable text 
box; see “Creating Toolbar Buttons and Shortcuts to Access the Browser from iNEWS” on 
page 67. 
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Entering Often Used Text or Graphics into a Replaceable Text Box

To enter often-used text or graphics into a replaceable text box with two simple 
keystrokes:

1. With the cell selected in the Deko Select Editor, press Alt+A to open a Shortcut 
Key Table. 

2. Press the letter of the macro you want to assign to the text box. 

In the iNEWS workstation, beside the story, you see a list of production cues corresponding 
to the graphics in the story. For more information, see the Avid iNEWS Help system.

Editing Text Boxes in a Graphic in an ENPS Story

To edit text boxes in a graphic in an ENPS story:

1. Double-click the Deko Select object production cue in the story.

2. The Deko Select Editor opens. An image of the template with the current information 
displays in the Preview Graphic. Current contents of replaceable text boxes appear in the 
table. 

3. Edit any of the replaceable text boxes in the table.

4. Click Save, then click Exit, or click Save and Exit. 

The edited graphic is now in the story, replacing its previous version.

n Exiting the program does not automatically save your work.

Production cue
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Changing Deko Select Graphic Templates but Preserving the Contents of Replaceable 
Text Boxes

To change Deko Select graphic templates but preserve contents of the replaceable 
text boxes:

1. Do one of the following:

t If the template you want to change is already open in the Editor but not yet inserted 
into the story, proceed to the next step.

t If the graphic has already been dropped into the story, double-click the Deko Select 
object production cue in the story (ENPS) or in the list of production cues 
(iNEWS). The graphic appears in the Editor.

2. Drag a different template and drop it into the Preview Graphic area of the Editor. The 
replaceable text boxes in this template are filled in with the text or files already entered 
into the editor to the extent that the text boxes correspond with those in the original 
template. Text from the first available text box of the original graphic template is entered 
into the first available text box of the new graphic template. A clip from the first 
available clip text box in the original graphic template is entered into the first available 
clip text box of the new graphic template, and so on. 

3. Do one of the following:

t If the original graphic was already in the story, select Save > Exit, or click Save and 
Exit. The new graphic is now in the story, replacing the previous version. 

t If the original graphic was not yet placed in the story, drag and drop the Preview 
Graphic into the story. 

Adding Breaks to a Rundown

Since it is important to be able to determine if a story is a “BREAK” story or not, Deko 
Select provides ways to flag this for both iNEWS and ENPS systems.

For more information, see the following topics:

• Adding Breaks to a Rundown in iNEWS

• Adding Breaks to a Rundown in ENPS

Adding Breaks to a Rundown in iNEWS
t To indicate a break if you use an iNEWS system, Avid recommends that you create an 

empty story with a title such as Break. The title of this story appears in the rundown to 
indicate a break, but does not trigger any action.
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Adding Breaks to a Rundown in ENPS

Within an ENPS system, Deko Select provides a convenient method of identifying 
commercial and station breaks. You can drag a special MOS event into a story in the 
rundown.

To add a break to the rundown in an ENPS system: 

1. In your NCS client interface, create a story specifically for this purpose, without text.

2. From the Windows desktop select Start > Programs > Accessories > WordPad.

n Avid recommends using WordPad, although other programs suitable for opening text files 
can be used.

3. Select File > Open.

The File Open dialog box opens.

4. Navigate to the BreakObject.txt file and open it. The BreakObject.txt file is provided on 
the Deko Select Installation CD.

5. Select the entire text of the BreakObject.txt file. 

6. Drag this text from WordPad and drop it into the story in the ENPS client interface. 

This creates a MOS event in the story window that indicates a break in the rundown.



Chapter 5

Support and Troubleshooting

This chapter includes important information for solving problems you might experience 
with your Deko Select, including:

• How to use the Gateway and other Deko Select interfaces for problem solving

• Solutions for some common problems

• How to prepare to contact Avid for support or upgrades

Deko Select has been designed for ease of use and superior performance. However, should 
you have trouble using your system for any reason, Avid wants your problem quickly and 
completely resolved. Avenues of support and information available include:

• This manual and other documentation shipped with your Deko Select

• Documentation describing the use of other products interfaced with Deko Select

• Customer Support, via e-mail and on the Web.

The following topics describe how to support and troubleshoot Deko Select:

• Using the Gateway for Problem Solving

• Troubleshooting from the DekoMOS Macro Server

• Troubleshooting from the Deko Select Client Browser

• Common Problems and Solutions

• Before You Contact Avid Technical Support
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Using the Gateway for Problem Solving

The DekoMOS Gateway offers logs showing details of Deko Select operation. You can 
configure the level of detail supplied by these logs. 

Because effective use of Deko Select depends on the communication of all four components 
with one another, problems might arise if one or more components are not sending or 
receiving information. The logs allow you to see precisely when and how components of 
Deko Select are communicating.

The Gateway also allows you to send a heartbeat to the NCS to test communication.

These functions are described in the following topics:

• “Viewing Deko Select Logs” on page 114

• “Configuring the Level of Information Displayed by the Log” on page 115

• “Clearing the Log” on page 116

• “Saving Logged Information” on page 117

• “Testing Communication with the NCS” on page 117

Viewing Deko Select Logs

To view Deko Select logs:

1. On the taskbar of the DekoMOS Gateway, click the DekoMOS Gateway icon. 

The DekoMOS Gateway dialog box opens, displaying a log of Gateway activity.

DekoMOS Gateway icon
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2. Click the Main/NCS Log tab, the Client Log tab, or the Playback Log tab to view 
activities of each Deko Select component. 

Configuring the Level of Information Displayed by the Log

To configure the level of information displayed by the log:

1. After opening the DekoMOS Gateway interface, click Configure. 

The DekoMOS Gateway Configuration dialog box opens.
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2. Click the General tab if it is not selected. 

3. In the Log Settings area, select or type values in the Max lines and Max line length text 
boxes. These specifications determine how much information displays in the log. To 
accommodate new information exceeding these specified maximums, the oldest 
information is deleted.

4. Select a Log Detail Level option to govern the detail displayed in the log. 

n Select Medium or High to display XML data.

5. Select Display Time in Log Lines to record the time of each logged event.

6. Click OK. 

Clearing the Log

To clear the log:

t In the main DekoMOS Gateway window, click Clear or press the Alt+R keys. 
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Saving Logged Information

To save logged information:

1. In the main DekoMOS Gateway window, click Log to File. 

Log files are automatically named as DekoMOS Gateway.AppLog.xx.txt, and they are 
located at C:\Program files\Avid\DekoMOS\. This setting remains, even from session to 
session, until you change it. 

2. Select the text and then click Copy. 

3. Click Start and then select Accessories > Notepad.

4. Paste the information into a Notepad file, and save it. 

Testing Communication with the NCS

To test communication with the NCS:

t In the main DekoMOS Gateway window, click Heartbeat or press the letter H. A 
message should return to the DekoMOS Gateway window. You see the message in 
the Log.

Troubleshooting from the DekoMOS Macro Server

The DekoMOS Macro Server keeps a log of all commands sent to the Macro Server and 
responses from the Macro Server during the most recent fourteen days. The activity for each 
day is in a file named with the date and saved in the Logs folder in the Macro 
Server directory.

To view files of logged Macro Server activity:

t Click Start button and then select ProgramFiles > Avid > DekoMOS > Logs.

Troubleshooting from the Deko Select Client 
Browser

To view files of logged client browser activity:

t Click the triangular arrow near the upper right of the window to see a list of the last ten 
logged activities. 
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Common Problems and Solutions

The following table offers possible solutions to common problems in several areas.

Common Problems and Solutions  

If this happens: Try this:

Connection Problems

The Client, or Macro Server can't 
connect to the Gateway.

Make sure all components are using the proper ports: 

• NCS Upper Port (Gateway <-> NRCS): 10540 

• NCS Lower Port (Gateway <-> NRCS): 10541 

• Client Port (Clients -> Gateway): 10542 

• Macro Server Port (MacroServer -> Gateway): 10543 

• Playback Port (PBC & MacroServer -> Gateway): 10544

• Verify IP addresses and UNC names.

The Gateway does not get a heartbeat 
from iNews.

Make sure you have the correct <network> name or <mos> setting in 
the Deko Select device in the MosConfig.xml on the iNEWS Gateway. 
Remember, the MOS ID is case sensitive. 

Clicking the Heartbeat button causes 
an infinite loop in ENPS.

Confirm that the MOS ID configured in the DekoMOS Gateway 
matches the one configured in ENPS.

The Gateway does not get a heartbeat 
from ENPS.

Make sure you have the correct ENPS system configuration for MOS.
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Graphics Files Problems

The Mini Preview appears to be 
missing some components of the 
original.dko file.

Check that all path settings referring to graphics components are 
correct.

Once text, stills, or clips are entered 
into a replaceable text box, the 
preview does not appear with the 
design as intended.

Template design within the Deko interface is critical. See the 
troubleshooting list for design on “Creating Templates” on page 71.

Double-clicking on a template does 
not display replaceable text boxes in 
the Editor. Picons work, but Previews 
do not.

This occurs if the Deko Renderer is not running because it cannot find 
the NetHASP. In the DekoMOS Gateway configuration window, click 
the Connections tab. Confirm that the IP address and port number in 
the NetHASP Connection Settings section are correct. This must 
correspond to the machine where the Net HASP is installed. Also, 
ensure that the NetHASP License Manager is running on the machine.

Installation Problems

The DekoMOS Macro Server 
installation fails with an error number 
119.

Make sure the Microsoft® XML Parser is installed by installing 
Internet Explorer version 5.0 or later before installing the Macro 
Server.

The Deko Select installer fails 
registering MsXml.dll on Win NT4.

Deko Select requires Internet Explorer 5.0 or higher. Install Internet 
Explorer 5.0 or higher.

Auto-update on a DekoMOS client 
fails to install.

From the Gateway, click Configure > General > Auto-Update 
Password. The Administrator Password popup appears. Check that the 
Name, Domain, and Password entered here belong to a valid local 
administrative account.

Software Problems

iNEWS crashes a minute after starting 
Deko Select.

Upgrade your iNEWS software to the latest version.

Deko Select locks up iNEWS on 
certain keys (e.g. shift-Tab). 

Upgrade your iNEWS software to the latest version.

Performance Problems

Loading a template or previewing a 
template takes a long time (40-50 
seconds) every other time it's 
attempted. 

Deko Select running on Windows XP without Service Pack 1 installed 
will cause this problem. If you are running Deko Select on a 
Windows XP platform, make sure Service Pack 1 is installed.

Common Problems and Solutions (Continued)  

If this happens: Try this:
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Before You Contact Avid Technical Support

Whenever you contact us for support, please include the following information:

• Product name and software version number

• Product serial number of any Avid hardware you are using

• Precise description of problem and attempted solutions

• Exact wording of any error messages

The Deko Select Browser does not 
display correctly. The grid, timecode, 
and spell check portions of the 
Browser are not correctly aligned.

The Windows display properties of the client must be set to 96 dpi. To 
set the Windows display properties to 96 dpi:

1. Click the Start button, and then select Control Panel > Display. 

2. Click the Settings tab and click the Advanced button. 

3. In the window that opens, select the General tab. 

4. Set the Display settings to 96 dpi. This can be achieved either by 
adjusting the Font Size, or on certain video adapters, directly 
through a dropdown list.

Macro Server Automation
 Problems

Starting the Macro Server produces 
these error messages:
Active X component can’t create 
object and Module might not work 
properly - 429.

This problem indicates that Automation is not enabled on the Deko. 
Confirm that the Automation option was purchased and enabled on 
the HASP.

Starting the Macro Server on Deko 
3000 3.0 produces an automation 
error.

Some Deko 3000 systems were distributed without Deko.tlb. Copy 
Deko.tlb from another Deko machine. A patch is also available from 
the Avid website:

http://www.avid.com/SupportFiles/Deko3000Patch003.zip

After installing the Macro Server, 
iNews Control Air no longer works.

The DekoMOS MacroServer automatically enables Unicode on the 
Deko. Control Air requires Unicode to be off. The Init.mcr used to 
start the Macro Server should be removed when using Control Air. As 
a result, the Macro Server must be manually started when using Deko 
Select, and shut down if switching back to Control Air.

Common Problems and Solutions (Continued)  

If this happens: Try this:
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To find information about the version of Deko Select that you are using:

1. In Deko Select, click the Information button.

The DekoMOS Browser dialog box opens containing information about this version of 
Deko Select.

2. Click the Version Info button for specific information about all applicable .dll files, .exe 
files, and .ocx files.

The Version Information dialog box opens.

3. Make a note of the information, and then click OK.
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Appendix A

Using the Spell Check Utility

You can use the Spell Check utility to check spelling of names and labels.

The following topics describe how to use the Spell Check Utility:

• Check-Spelling Dialog Box

• Dictionaries Dialog Box

• Options Dialog Box

• New Dictionary Dialog Box

Check-Spelling Dialog Box

The Check-Spelling dialog box opens if a word requiring your attention is detected after you 
invoke spell checking. You can use the dialog box to specify whether the word should be 
ignored or replaced. The labels of some buttons and text boxes in the dialog box change 
according to the context

.
Check-Spelling Dialog Box Options  

Option Description

Add Click to add the reported word to the dictionary selected in the Add Words To list. 
Click the Add button if a correctly spelled word you use often is reported as a 
misspelling (e.g., your family name). If the word is not used frequently, you might 
want to select the Ignore or Ignore All buttons instead. This button is enabled only if 
a user dictionary has been selected in the Add Words To list.

Add Words To Select from the list to indicate to which user dictionary words will be added when 
you click the Add button. The Add Words To list shows all user dictionaries 
currently open.

Cancel Stops the current spelling check.
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Capitalization Appears if you use an uncapitalized word that exists in the dictionaries in capitalized 
form only. You can edit the word in this box or select a suggestion from the list, then 
click the Change button to correct the word, or press the Ignore button to skip 
the word.

Change Use to replace the reported word. If the problem word was edited, the edited word is 
used as the replacement. Otherwise, the selected suggestion is used as the 
replacement. Only this occurrence of the reported word is replaced. If you want this 
and all following occurrences of the word replaced, select the Change All button.

Change All Use to replace this and all following occurrences of the reported word. If the 
problem word was edited, the edited word is used as the replacement. Otherwise, the 
selected suggestion is used as the replacement. If you want only this occurrence of 
the word to be replaced, use the Change button. If the reported word is one you 
frequently misspell, you might consider adding it to a user dictionary. You can 
display the Dictionaries dialog box by clicking the Dictionaries button.

Consider Changing Contains a word that might be misspelled or otherwise incorrect, and presents a 
candidate replacement word. You can change the word by clicking the Change 
button, or skip it by clicking the Ignore button.

Delete Click to remove the word from the text. This button appears when a doubled word 
has been detected, or when the contents of the problem-word box are deleted.

Dictionaries Click to display the Dictionaries dialog box. You can use the Dictionaries dialog box 
to open or close user dictionaries, and to edit the contents of user dictionaries.

Ignore Click to skip this occurrence of a misspelled word. If the same misspelled word 
appears later, it will be reported again.

Ignore All Click to skip this and all further occurrences of a misspelled word. You might use 
this button if the word reported as a misspelling is actually spelled correctly. If the 
word is one you use frequently, you might want to ignore it permanently by selecting 
the Add button.

Not in dictionary Indicates a misspelled word. The word is considered misspelled because it could not 
be located in any open dictionaries, or was marked with an exclude action. You can 
edit the word in this box or select a suggestion from the list, then click the Change 
button to correct the word, or press the Ignore button to skip the word.

Options Click to display the Options dialog box. You can use the Options dialog box to set 
spelling-checker options. 

Check-Spelling Dialog Box Options (Continued)  

Option Description
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Dictionaries Dialog Box

The Dictionaries dialog box allows you to open and close user dictionaries, and to edit the 
contents of an open user dictionary. The contents of dictionaries are saved in disk files. You 
can open some or all of your user dictionary files at any time. Only open dictionaries are 
searched during a spelling check.

Action List

Use this list to select an action that is associated with words in the dictionary. The action 
tells the spelling checker what to do when it finds a word in the dictionary. You can select the 
options in the following table.

Auto change (use case 
of checked word)

This action allows you to automatically replace one word with another. For example, 
if you often type recieve instead of receive, you might type the word recieve with 
receive as the other word and “Auto change (use case of checked word)” as the 
action. The spelling checker will automatically correct recieve wherever it appears. 
If recieve was capitalized (Recieve), the spelling checker would automatically 
replace it with Receive. Note that the replacement is made automatically only if the 
“Auto Change” option is enabled.

Suggest Click to search more thoroughly for suggested replacements for the current 
misspelled word. Each time you press the Suggest button, a more in depth search is 
made. The Suggest button is disabled after all possible suggestions have 
been located.

Suggestions Contains a list of suggested replacements for the word reported as misspelled. 
Subsequent presses of the Suggest button might yield more suggestions. The word 
selected in the Suggestions list will be used as the replacement when the Change or 
Change All buttons are pressed, unless the word in the problem box was edited.

Undo Click to remove the last change made. The Undo button can be pressed several times 
to remove the last several changes.

Undo Edit Click to remove any changes made to the text in the problem box. This button 
appears only if the text in the problem box has been changed.

Check-Spelling Dialog Box Options (Continued)  

Option Description
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:

The Dictionaries dialog box includes additional options as described in the following table.

Dictionaries Dialog Box Action List Options  

Option Description

Auto change (use case 
of other word)

This action allows you to automatically replace one word with another, always with 
the same case pattern as the other word. This action is useful for automatically 
expanding abbreviations. For example, you could type the word TBD with to be 
determined as the other word and “Auto change (use case of other word)” as the 
action. The spelling checker will automatically replace TBD with to be determined 
wherever it appears. Note that the replacement is made automatically only if the 
“Auto Change” option is enabled.

Conditionally change 
(use case of checked 
word)

This action allows you to optionally replace one word with another. For example, if 
you often type recieve instead of receive, you might type the word recieve with 
receive as the other word and “Auto change (use case of checked word)” as the 
action. The spelling checker will ask if you want to replace recieve with receive. If 
recieve was capitalized (Recieve), the spelling checker would ask if you wanted to 
replace it with Receive.

Conditionally change 
(use case of other word)

This action allows you to optionally replace one word with another, always with the 
same case pattern as the other word. This action is useful for optionally expanding 
abbreviations. For example, you could type the word TBD with to be determined as 
the other word and “Conditionally change (use case of other word)” as the action. 
The spelling checker will ask if you want to replace TBD with to be determined.

Exclude (treat as 
misspelled)

This action tells the spelling checker that the word is misspelled, even if it is listed in 
another dictionary. Words marked with this action will never be offered as 
suggestions for misspelled words, and they will be reported as misspellings when 
they are encountered by the spelling checker. Note that the spelling checker looks up 
words in user dictionaries in the order in which they appear in the Files list. If you 
want to exclude a word, make sure it doesn't appear in a previous user dictionary.

Ignore (skip) This action tells the spelling checker that the word is spelled correctly, and so can be 
skipped over. This is the most common action.

Dictionaries Dialog Box Action Other Options  

Option Description

Add File Click to open a user dictionary file. When you select the Add File button, a dialog 
box opens that you can use to select the dictionary file to open. The set of open 
dictionary files is remembered, so once you add a dictionary file you don't need to 
add it again. If you need to create a new user dictionary, use the New button. You can 
open other applications' user dictionary files.
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Add Word Click to add the word typed in the edit area of the Words list to the currently selected 
dictionary. The currently selected action and other word are associated with the word. 
You can use the Add Word button to change the action or other word associated with 
a word. Note that the Add Word button is enabled only when a new word is typed in 
the edit area of the Words list. The words you add might contain virtually any 
character, but only words which contain embedded periods should have trailing 
periods (for example, U.S.A. is OK, but USA. is not).

Close Click to close the Dictionaries dialog box.

Delete Word Click to remove the word appearing in the edit area of the Words list from the 
currently selected dictionary. The associated action and other word are also removed.

Export Click to save the contents of the currently selected dictionary to a text file. When you 
select the Export button, a dialog box opens which you can use to select the name of 
the text file to which words in the dictionary will be exported. The words are written 
to the file one per line.

Files This text box contains the list of open dictionary files. Select a file from the list, to 
display its contents in the Words list.

Import Click to add the words contained within a text file to the currently selected dictionary. 
When you select the Import button, a dialog box opens which you can use to select 
the text file to be imported. Each word in the selected file is loaded into the 
dictionary. Note that importing a large list of words might take some time.

Language Displays the language (for example, English or French) of the words in the currently 
selected dictionary.

New Click to create a new user dictionary file. When you select the New button, a dialog 
box opens to specify attributes of the new dictionary. 

Other Word Contains an alternate word associated with the currently selected word. The other 
word is used in the “Auto change” and “Conditionally change” actions to supply a 
replacement word. You can type more than one word in the Other Word box, but the 
total length should be limited to 63 characters.

Remove File Click to close the currently selected dictionary file. Closed dictionaries are not 
checked during a spelling check. Although the file is closed, it is not deleted. Closed 
dictionary files can be later reopened using the Add File button.

Words Contains the list of words in the currently selected user dictionary.

Dictionaries Dialog Box Action Other Options (Continued)  

Option Description
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Options Dialog Box

You can use the Options dialog box to specify various spelling-checker options. These 
options affect the way the spelling checker operates.

Options Dialog Box Options  

Ignore Capitalized 
Words

When enabled, any words beginning with a capital letter are ignored (that is, are 
skipped over without being checked). You can enable this option if the text being 
checked contains many proper names.

Ignore Words with 
Numbers

When enabled, any words containing embedded digits are ignored (that is, are 
skipped without being checked). Examples of such words include Win95 and Q4. 
You can enable this option if the text being checked contains many code words or 
other symbols containing digits.

Ignore Words with 
Mixed Case

When enabled, any words containing an unusual mixture of upper- and lower-case 
letters are ignored (i.e., are skipped without being checked). Examples of such words 
include MicroHouse and CapsLock. You can enable this option if the text being 
checked contains many variable names or other symbols which use case changes to 
distinguish words.

Ignore Domain Names When enabled, any words that appear to be Internet domain names (such as 
wintertree-software.com) are ignored (i.e., are skipped without being checked).

Report Doubled Words When enabled, any word appearing twice in a row is reported in the 
Check-Spelling Dialog.

Case Sensitive When enabled, a distinction is made between capitalized and non-capitalized words. 
For example, canada is considered different from Canada, so canada would be 
reported as a misspelling. When the option is disabled, canada and Canada are 
considered identical. The performance of the spelling checker will be reduced if this 
option is disabled.

Phonetic Suggestions When enabled, suggestions are made based on phonetic (sounds-like) similarity to 
the misspelled word. This option tends to improve suggestions for badly misspelled 
words. Enabling this option will increase the time required to locate suggestions. 
Either this option or the Typographical Suggestions option must be enabled or no 
suggestions will be offered.

Typographical 
Suggestions

When enabled, suggestions are made based on typographical (looks-like) similarity 
to the misspelled word. This option is appropriate for people who are generally good 
spellers. Either this option or the Phonetic Suggestions option must be enabled or no 
suggestions will be offered.

Suggest Split Words When enabled, two separate words will be suggested as a replacement for a 
misspelling containing two joined words. For example, is the would be suggested as 
a replacement for isthe.
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New Dictionary Dialog Box

You can use the New Dictionary dialog box to specify the attributes of a new user dictionary.

Auto Correct When enabled, words marked with “Auto Change” actions will automatically be 
changed to their specified replacements. When disabled, you will be prompted 
before the words are changed.

Main Dictionary 
Language

This option allows you to set the language of the main dictionary used to check 
spelling. The list shows only languages for which dictionaries are installed on your 
system. To check spelling in a different language, select the language in the list.

Suggestions When a misspelled word is detected, a search is automatically made for suggestions. 
This option controls the speed and accuracy of this automatic search. Pressing the 
Suggest button in the Check-Spelling Dialog causes an increasingly more accurate 
(but slower) search for suggestions.

OK Click to close the Options dialog box, and save any changes made to the 
option settings.

Cancel Click to close the Options dialog box, and discard any changes made to the 
option settings.

Options Dialog Box Options (Continued)  

New Dictionary Dialog Box Options  

Browse Click to display a dialog box that shows the names of other user dictionary files. You 
can use the dialog box to view the names of existing dictionary files, and to type the 
name of the new dictionary file.

File Name Contains the name of the disk file used to hold the contents of the new dictionary. You 
can type a name here or use the Browse button to display a dialog box showing the 
names of other dictionary files.

Language Specifies the language (for example, French, English) of the words the new user 
dictionary will contain. If the language you want to use is not listed, select “Any.”

OK Click to close the New Dictionary dialog box and create the new dictionary.
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Appendix B

Displaying Languages

Latin-based languages such as French, Spanish, Italian, and German, all use the same 
character set as English, which is also a Latin-based language. Other languages, such as 
Arabic, Russian, and Japanese use different character sets. The language or languages that 
you can display with your Deko product depend upon Windows system settings. With the 
system configured correctly to display the language you want, you might also need to select 
an appropriate font within the Deko product application.

n Deko currently uses single-byte characters to recall the appropriate glyph to display a 
character.When a byte is sent to Deko, Deko converts it to Unicode according to the current 
code page. The information is then maintained internally in Deko in Unicode. Most Truetype 
fonts have more than one lookup table. If they have more than 256 glyphs, then they must be 
able to find those glyphs, usually with a Unicode lookup table. Before Unicode, many non-
Latin applications supplied their own fonts where all the glyphs are in the first 256 positions. 
The applications had their own tables to know where the glyphs were stored. These fonts do 
not work properly with more modern applications. 

The following topic describes how to set up your Deko product to display languages:

• Selecting a Language for Your Deko Product
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Selecting a Language for Your Deko Product
To select a language for your Deko product:

1. Determine the operating system of your Deko product: Windows 2000, or Windows XP. 
For more information, see “Determining the Operating System of Your Deko Product” 
on page 132.

2. Follow the appropriate procedure for configuring that operating system to display the 
language you want. 

For more information, see the topic that matches your operating system:

- “Configuring Windows 2000 Based Products to Display Non-Latin Character Sets” 
on page 133.

- “Configuring Windows XP Based Products to Display Non-Latin Character Sets” 
on page 137

3. Within the Deko application, choose an appropriate font.

Determining the Operating System of Your Deko Product

To determine the operating system of your Deko product:

t Click Start and select My Computer > View system information. 

The System Properties window opens. The operating system is listed on the General tab.

These functions are described in the following topics:

• “Configuring Windows 2000 Based Products to Display Non-Latin Character Sets” on 
page 133

• “Configuring Windows XP Based Products to Display Non-Latin Character Sets” on 
page 137
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Configuring Windows 2000 Based Products to Display Non-Latin 
Character Sets

To configure Windows 2000 based products to display a non-Latin character set:

1. Click the Start button and select Settings > Control Panel > Regional Options.

The Regional Options dialog box opens. 

2. Select the General tab if it is not already selected.
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3. In the “Language settings for the system” area, click to place a check beside the 
character set that is appropriate for the language you want.

4. Click OK.
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5. Windows displays a prompt to insert the Windows 2000 Professional CD into drive H. 
Insert the CD, the click OK.

6. If prompted that Windows cannot find the needed files, click the Browse button, browse 
to J:\I386 on the Windows 2000 CD, and click OK. If you do not see this prompt, 
proceed with the next step.

7. When prompted to restart your computer, click Yes.

8. After restarting, click Start and then select Settings > Control Panel > Regional Options. 
Select the General tab if it is not already selected.

9. Select Set default to display the Select System Locale dialog box.

10. From the list, select the language you want to display.

11. Select OK > OK.

12. When prompted that the required files are already on the hard disk, click Yes.

13. When prompted to restart, click Yes.
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14. Select Start > Control Panel >  Regional Settings. Select the General tab.

15. Select the appropriate location from the Your locale list.

16. Click the Input Locales tab.

17. In the Input Language area, select the appropriate language, then select Set as Default. 

18. Click OK.
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Configuring Windows XP Based Products to Display Non-Latin 
Character Sets

To configure Windows XP based products to display a non-Latin character set:

1. Click the Start button and select Settings > Control Panel > Regional Options.

The Regional and Language Options window opens.

2. Click the Advanced tab. In the Code page conversion tables area select the character set 
you want to install and then click OK. 

A message box to insert the Windows XP CD opens. 

3. Insert the Windows XP CD and click OK.
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If a message box opens to state that Windows cannot find the needed files, click the 
Browse button and browse to the i386 folder on the Windows XP CD, and then 
click OK.

4. Click Apply. 

5. Follow the onscreen prompts. When prompted to restart, click Yes.

6. After the computer restarts, click the Start button and select Settings > Control Panel > 
Regional and Language Options.

7. Click the Regional Options tab. Click the list in the Standards and Formats area and 
click to select a language.

8. In the Location area, select your location from the list.
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9. Click the Languages tab, then click the Details button.

10. In the Text Services and Input Languages window, click OK.

11. Click the Advanced tab. In the Language for non-Unicode programs, select the language 
you want to use. 

12. Click OK.

13. When prompted that the required files already are on the hard disk, click Yes.

14. When prompted to restart, click Yes. The system is now configured to use the non-Latin 
Character set you selected.
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Glossary

Browser A Client program (software) that is used to look at various kinds of resources across a 
network. 

Client A software program that is used to contact and obtain data from a Server software 
program on another computer, either nearby or far away. Each Client program is 
designed to work with one or more specific kinds of Server programs, and each Server 
requires a specific kind of Client. A Web Browser is a specific kind of Client.

FTP File Transfer Protocol is a protocol for transferring files from one computer to 
another. A protocol is an agreed upon format for transmitting data between two 
devices. Protocol determines the type of error checking to be used, compression 
method, if any, how the sending device will indicate that it has finished sending a 
message, and how the receiving device will indicate that it has received a message. 

IP Address Internet Protocol Address, an identifier for a computer or device on a TCP/IP 
network. Networks using the TCP/IP protocol route messages based on the IP address 
of the destination. The format of an IP address is a 32-bit numeric address written as 
four numbers separated by periods. Each number can be zero to 255. For example, 
1.160.10.240 could be an IP address. 

Within an isolated network, you can assign IP addresses at random as long as each one 
is unique. However, connecting a private network to the Internet requires using 
registered IP addresses (called Internet addresses) to avoid duplicates. The four 
numbers in an IP address are used in different ways to identify a particular network 
and a host on that network. 

Operating 
System 

Every general-purpose computer must have an operating system to run other 
programs. Operating systems perform basic tasks, such as recognizing input from the 
keyboard, sending output to the display screen, keeping track of files and directories 
on the disk, and controlling peripheral devices such as disk drives and printers. 

Operating systems provide a software platform on top of which other programs, called 
application programs, can run. The application programs must be written to run on top 
of a particular operating system. Your choice of operating system, therefore, 
determines to a great extent the applications you can run. For PCs, the most popular 
operating systems are DOS, OS/2, and Windows, but others are available, such 
as Linux. 
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As a user, you normally interact with the operating system through a set of 
commands. For example, the DOS operating system contains commands such as 
COPY and RENAME for copying files and changing the names of files, respectively. 
The commands are accepted and executed by a part of the operating system called the 
command processor or command line interpreter. Graphical user interfaces allow you 
to enter commands by clicking, with a mouse, objects that appear on the screen. 

Parallel 
Port

An interface for connecting an external device such as a printer. Most personal 
computers have both a parallel port and at least one serial port. 

On PCs, the parallel port uses a 25-pin connector (type DB-25) and is used to connect 
printers, computers, and other devices that need relatively high bandwidth. It is 
sometimes called a Centronics® interface after the company that designed the original 
standard for parallel communication between a computer and printer. The modern 
parallel interface is based on a design by Epson™. 

Port (1) An interface on a computer to which you can connect a device. Personal 
computers have various types of ports. Internally, there are several ports for 
connecting disk drives, display screens, and keyboards. Externally, personal 
computers have ports for connecting modems, printers, mice, and other peripheral 
devices. 

Almost all personal computers come with a serial RS-232C port or RS-422 port for 
connecting a modem or mouse and a parallel port or USB port for connecting a 
printer. 

(2) In networks, an endpoint to a logical connection; the place, internally, where one 
computer listens for information from another computer. The port number identifies 
what type of port it is. For example, port 80 is used for HTTP traffic. 

(3) To move a program from one type of computer to another. To port an application, 
you need to rewrite sections that are machine dependent, and then recompile the 
program on the new computer.

Server A computer, or a software package, that provides a specific kind of service to client 
software running on other computers. The term can see a particular piece of software, 
such as a Web server, or to the machine on which the software is running, e.g. “Our 
mail server is down today. That's why e-mail isn't getting out.” 

A single server machine can have several different server software packages running 
on it, thus providing many different servers to clients on the network. Sometimes 
server software is designed so that additional capabilities can be added to the main 
program by adding small programs known as surfeits. 
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USB Port Universal Serial Bus, an external bus standard that supports data transfer rates of 12 
Mbps. A single USB port can be used to connect up to 127 peripheral devices, such as 
mice, modems, and keyboards. USB also supports Plug-and-Play installation and hot 
plugging. 

Starting in 1996, a few computer manufacturers started including USB support in 
their new machines. USB is now used widely. It is expected to completely replace 
serial and parallel ports.

 UNC Universal Naming Convention or Uniform Naming Convention, a PC format for 
specifying the location of resources on a local-area network (LAN). UNC uses the 
following format: 

\\server-name\shared-resource-pathname 

So, for example, to access the file test.txt in the directory examples on the shared 
server silo, you would write: 

\\silo\examples\test.txt 

You can also use UNC to identify shared peripheral devices, such as printers. The idea 
behind UNC is to provide a format so that each shared resource can be identified with 
a unique address. 

UNC is supported by Windows and many network operating systems.

XML Extensible Markup Language. XML enables the definition, transmission, validation, 
and interpretation of data between applications and between organizations.
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 A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

A
access

new or modified templates 85
add file to Favorites list 100
add graphics to story 101
administrator password 37
appearance of graphics 50
Artbox 46
aspect ratio 82
Associated Press 17
auto-updates 37
Avid Graphics Select 88
Avid Technology 17

B
break, add to a rundown 111
browser 141
browser display preferences 93
browser features 90
browser installation 61
browser, DekoMOS 20
browsers, configure access to other 46

C
change style name 53
clear DekoMOS Gateway log 116
client 141
Client Auto-Update settings, DekoMOS Gateway 41
client computer 61
client gateway configuration 63
client style settings 50, 54
clip layer creation 80
clips prepared for use with templates 83
compatibility

with previous versions of DekoMOS 28
components 33
configure

Deko Select Browser 62
configure editor macros 43
connection problems 118
connections 39
create templates 71

D
default graphic duration 96
default settings 27
Deko

events 101
plug-in defined 15
spell checking 102

Deko graphic creation 72
Deko Select Browser

configuration 62
Deko Select events

Inserting into iNEWS Stories 101
Deko Select, about 26
Deko templates 71
DekoMOS Browser 20, 61
DekoMOS Browser preferences 93
DekoMOS client

Gateway settings 64
user preferences 93

DekoMOS components 33
DekoMOS Editor 97
DekoMOS Gateway 22
DekoMOS Gateway, installation and configuration 

33
DekoMOS Macro Server 23, 56
DekoMOS, about 17
delete, style 54

Index
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Dictionaries dialog box 125
dictionary

user defined 129
dongle 32
duration

configure default for graphics 96

E
edit graphic in ENPS story 110
editor 97
editor macros 43, 110
enable additional options 55
enable additional users 55
enabled options and users 54
ENPS 17

before installing on 28
ENPS MOS settings 28
events

tagged 103

F
fail-over NCS 39
Favorite Templates list 97, 100
file log information 117
file storage structure 27, 83
filenames

display in browser 97
fonts 27
FTP 141

G
gateway as a tool for troubleshooting 114
Gateway settings

DekoMOS client 64
gateway, DekoMOS 22
gateway, installation and configuration 33
General Settings, DekoMOS Gateway 36, 42
graphic browsers 43
graphics in a story 101
graphics problems 119

H
heartbeat 117

hotkey configuration 44
hotkey entry of commonly used text or graphics 110
hotkey entry of graphic files 100
hotkey to access template 100

I
iNEWS 17
ini file for Gateway settings 64
in-line spell check 92, 98
Inserting

Deko Select events into iNEWS Stories 101
installation 25
installation problems 119
IP address 141

L
languages

non-English with DekoMOS 27
license manager 32
locations 69
log 114

Macro Server activity 117
log configuration 115
log on name

DekoMOS client 91
log settings 38
Log Settings, DekoMOS Gateway 38
log to file 117

M
macro server 56
macro server installation 56
macro server, DekoMOS 23
macro shortcuts 43, 110
macro to start the DekoMOS macro server 57
macros for entering often used text or graphics 44
Media Object Server 17
MOS 16
MOS ID 40

N
NCS 16, 39
Net HASP 54
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Net HASP Connection Settings 41
Net HASP dongle 32
Newsroom Computer System 16
newsroom processes 16

O
operating system 141
options 54

P
parallel port 142
password 37
paths 36
performance problems 119, 120
picons 97

display in browser 97
Pinnacle Systems, how to contact 120
Plug-ins 88
port 142
port number 27
preserve contents

when changing templates 111
Primary machine control event 101
primary NCS 39
Procedures

edit a Deko event in iNEWS 104
insert a DekoMOS event into the story form 101
inserting a DekoMOS event in iNEWS 101
install Avid Deko Select 61

Proximity 46

R
replaceable elements file structure 84
replaceable layer creation 72

S
safe title area 43
scaling 82
server 142
set connections 39
shortcut to access template 100
shortcuts 69
spell check 96, 98, 123

spell check dictionaries 125
spell check dictionary 37

user defined 129
spell check options 128
Spell checking dialog box 123
startup macro 57
startup settings 38
static design elements for templates 82
static elements file structure 84
still layer creation 78
story, adding graphics to 101
style settings 50
style, add and define paths 50
style, change appearance 54
style, change name 53
style, delete 54
styles and paths on the DekoMOS Macro Server 59
system compatibility 18

T
Tagged event 103
technical support 120
template

display filename or picon 97
template creation 71
template file structure 83
test communication with the NCS 117
text layer creation 75
textures 82
thumbnails 97
Thunder Select 88
time code 42
troubleshoot

from the Gateway 114
troubleshooting chart 118
troubleshooting from the DekoMOS Gateway 114
troubleshooting from the Macro Server 117
troubleshooting graphics 81, 119

U
UNC 143
USB port 143
user preferences

DekoMOS client 93
user settings 37
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users enabled on the Net HASP 54

V
version information 121

X
Xenotrack 46
XML 143
XML storage 36
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